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I'm not normally one to quote
Forrest Gump, but this issue
really feels like a box of
chocolates. There’s such a
dazzling variety of art,

inspiration and skill on show '
Share your art with the world

that when you turn each page Showcasing talent is at the heart of what we do. Go to
you never know what you're page 10 to see how you can easily submit your work.
going to get.

This smorgasbord of tools and techniques handily
highlights the wide-ranging industry we represent
- varied, unique, exciting and international.

There’s ZBrush and Photoshop advice from
The Mill’'s Adam Dewhirst, Art Centre College of
Design’s Ara Kermanikian creates a workshop on
mech modelling, the UK’s Glen Southern gives
insight into VR, while France’s Nicolas Delort
reveals his scratchboard process... and who couldn’t
be taken by Norway’s Even Mehl Amundsen’s cover

Hollywood or bust!
art? I love Even’s work! Iloved Pablo Carpio’s enthusiastic approach to realising
If you're stuck in the artistic doldrums, you won't his childhood dream of making it as an artist.

fail to be uplifted by Mel Milton's inspiring guide to
getting motivated - even his Instagram profile
(@melmadedooks) perks me up! Oh, and why not
give us a follow (@imaginefxmagazine) while
you're there, too! As ever, please let me know your
thoughts at the email address below...

Claire Howlett, Editor ' Oculus Medium workshop
claire @imaginefx.com Our friend Glen Southern shares his brilliant virtual

reality techniques with us in a video and workshop.

M mail@imaginefx.com | s | - s I\ Software
¥ @imaginefx . e “¥ex 18| offer!

: : w B Find out how you
f facebook.com/imaginefx * /= - 27\ | can get ArtRage Lite

© @imaginefxmagazine . 1N B Il | worth $30) for FREE

Turn the page for

B imaginefx.creativeblog.com more details...
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Take out a new subscription to our print or print and digital
editions, and you'll receive a FREE COPY of ArtRage Lite!
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today!
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Subscribe to save money
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Subscribers receive issues
with text-free covers.
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to your door or device.
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Key Features

# Recreate the look of natural
media: pencil, oils, inks and more.

# Define the look and feel of your
canvas with texture and lighting.

@ Intuitive interface with floating |
tool panels makes painting easier.

PRINT PRINT & DIGITAL

UK £16 £19

WROPE @8 85 SUBSCRIBE
Us | 1 s AND SAVE!

REST OF WORLD §39 M1

Two easy ways to subscribe today...

VISIT WWW.MYFAVOURITEMAGAZINES.CO.UK/IFXPQ17

OR TELEPHONE 0344 848 2852 (UK)
+44 (0) 544 848 2852 (INTERNATIONAL)

This offer entitles new print subscribers and print and digital subscribers a free downloadable copy of ArtRage Lite. You will receive an email with all the software details and instructions on how to download. Please make sure you add your
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Your art

10 FXPosé
We show your gorgeous art to the world!

News and events

20 Isittime yougot

to grips with 3D software?

Is mastering 3D software the key to
artistic success, or does it have its
limitations? Dom Carter discovers
that the answer’s not clear cut...

26 Artistin Residence

Giuseppe “Peppe” Cristiano reveals that
his studio is the place where he wants to
spend time, not just work.

Features

32 Studio Profile: 5518 Studios
Based in US and Russia, the art production
company tells us how it creates 2D and 3D
art for the video games industry.

38 Interview: Pablo Carpio
From having no job to working for Disney
and Marvel - Gary Evans learns how this

artist’s Hollywood gamble paid off. .. Artist POthO lio
48 Sketchbook: Bastien Grivet P AB lo
The look of the future appeals to this artist,

who likes to sketch sleek buildings atop

distant mountain peaks in his spare time. c AR PI 0
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Workshops

56 Plan and paint a striking figure
Even Mehl Amundsen solves lighting and
anatomy issues as he paints a tribal figure.

62 Quickly work up a 3D concept
Adam Dewhirst conceives an idea in
ZBrush and then works it up in Photoshop.

. T G 68 Core Skills: Photoshop
Make the most of masks, vector masks

l,' .:_ i ) 3 A
L Yorikcup a concept inZByishy and clipping masks, with Mark White.

72 15 ways to get motivated
Follow Mel Milton’s tips for enhancing
your productivity and creativity levels.

78 Model a scene for a paint-over
Ara Kermanikian uses ZBrush to model a
sci-fi composition, ready for a paint-over.

84 Character creationin VR

See how Glen Southern brings a 2D
concept to life in three dimensions.

Model a scene in 3D

Traditional Artist

100 Traditional art FXPosé
We showcase the best art created using
traditional methods, sent in by you!

104 Draw an iconic fantasy
encounter from Middle-earth
Nicolas Delort creates a dramatic black
and white clayboard illustration.

110 Core Skills: Watercolour

Join artist and tutor Kelly McKernan in
discovering how to work with, not against,
this wonderfully surprising medium.

114 First Impressions:

Yoann Lossel

An ancient forest had a deep and lasting
effect on this French artist. ..

:
July 2018  lifidgiiieEX #
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Resources

_©®Resources

Getting hold of this issue’s videos and custom
brushes is quick and easy. Just visit our dedicated 3 H
web page at https://ifxm.ag/beadigitall62artist of videg tutona1s

Tom pro artjsts

WORKSHOP | (0 watch anq

learn from|

) (a0) () (o0) 4

Create a cute critter in virtual reality

Glen Southern’s video is an eye-opening insight into how he uses Oculus Medium to bring a
2D creature concept to life in three dimensions. It's the future! His workshop is over on page 84.

You're three steps away from
this issue’s resource files...

Go to the website

Type this into your browser’s
address bar (not the search bar):
https://ifxm.ag/beadigital162artist

Find the files you want
Search through the list of
resources to download.

Download what you need...

...or alternatively watch the
videos on our YouTube page.

# iiaEsieX July 2018
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F U T U n E Connectors.

Creators.
- Experience
o ot e o o Makers.
Master Photoshop masks Sci-Fi Corridor et bty sty s

London Stock Exchange Chief financial officer Penny Ladkin-Brand

Mark White explains the basics of Photoshop’s Check out this clip from Vaughan Ling's igmbot T S i i
masking tools in this video. More on page 68.  instructional video. We review it on page 95. .
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- THE PLACE TO SHARE YOUR DIGITAL ART
ul — - = e ————
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5 . ‘-.”_-". Sl
-LimWelLun  °
OCATION: Singapore MEDIA: Photoshop WEB: www.pixiv.me/jéllysonic

Lim is heavily influenced by anime and music, and

Ve s ’ ad
B T — i enjoys using colours to convey different emotions. He 0’ s
i o works ‘x.Nith Collateral Damage Studios in Singapore. _ "g :

Wis - i3
'submit your work? Visit http://ifxm.ag/getinifx
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“Ripgles and fallen cherry blossom petals * %

1 help show how water can inter'act':\_Nith its \ .-

. . surroundings. I chose top-down lighting to .
.+, focus thé attention oh the chara_cte_r_i,s.” \
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=1 Darren Goldman

t us Procreate www.darrengoldman.com

Darren’s aesthetic is a blend of Jim Henson, Edward Gorey and Margaret
Keane. He has a weakness for ‘pathetically cute’ creatures, and one of his

biggest inspirations is his Boston Terrier Lola.

SLOW IT DOWN

“| blurred the lines between fantasy art and
photorealism, and limited my colour palette
to create a dreamlike yet believable world.
There’s a Muppet influence in there, too.”

TEETH FAIRY

“Inspired by the Hellboy franchise, |
wanted to take the concept of the tooth fairy
down a more disturbing path. | played with
transparency to create believable movement
for the wings.”

ALIEN LANDSCAPE

“| paint a lot of character-centric pieces,
so | challenged myself to focus on the larger
landscape here. | kept my colour palette
minimal and played with the contrast in
values to show depth.”

TRASH TROUBLES

“| wanted to combine my love of yetis
(and yeti-like creatures) and my
environmental concerns. | used wide, flat
brushes to achieve a more painterly style.”

w lifiasimerX July 2018 Want to submit your work? Visit http://ifxm.ag/getinifx
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Whitney Salgado

us Photoshop www.whitneysalgado.com
Whitney lives and works in Milwaukee, US. “I enjoy mixing
unusual ideas and playing with colour in a way that creates
an inviting image and leaves you with a smile,” she tells us.

MSFF

“This piece was for
the Milwaukee Short Film
Festival. It shows a creature
who sees faces in smoke.”

SEUSS

“Just a fun portrait of
Dr. Seuss interacting with
his characters.”

VOICES HEARD

“| painted this for the
Voices Heard! programme.
It depicts a Latinx woman
in her own world.”

X-RAY

“This painting is based
on a piece of poetry. Init,
a mother describes the
tumours evident in her
daughter’s CAT scan, as
‘islands washing her away’.



XPosé

Nadzeya Makeyeva

LOCATION: Belarus MEDIA: Photoshop, pencils WEE: nadzeya-makeyeva.com/gallery

Nadzeya is a multidisciplinary artist who has drawn every day
since she was a child. “I’'m an illustration maniac,” she says,
“and my goal is to create bizarre, unique artworks.”

VELOCIRAPTOR

“This velociraptor was used as a lucky
mascot for the Mad Rabbit travel T-shirt
campaign. | also used the illustration
as a silkscreen print on a separate range
of T-shirts.”

ARTICHOKE ELF

“This is the first illustration in my
upcoming series of fairy botanical
creatures. It’s based on the idea that all
plants have their own spirit and character.”

Want to submit your work? Visit http://ifxm.ag/getinifx
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GOOD SIDE

“The artwork for the
Goodbye June single Good
Side. The band requested
a mix of hand-drawn and
realistic digital painting, but
also wanted it to be unique
and a bit psychedelic.”

P

MAD RABBIT1,2,3

“I had some free time
between commercial jobs
and decided to create some
personal illustrations of
absolutely insane rabbits
characters. After | published
them on Behance they went
viral, and a number of people
got in touch asking to use
them for clothing prints
and patterns.”

Want to submit your work? Visit http://ifxm.ag/getinifx



{ Niyas Syed
India Photoshop, 3D-Coat, Vue www.niyasck.com
. Niyas started as a lighting artist, and moved from
one discipline to another until he found concept art
and was hooked. He now works as a freelance artist.

PLANET STORENUS VERTICAL VILLAGE CYBERPUNK TRAIN

“A planet with a red “As the numbers of YARD
atmosphere (not Mars) inhabitants has increased, “My goal in this image was to
somewhere in the galaxy, they have built vertical depict a fictional cyberpunk
where humans have built blocks that satisfy the basic train yard city, drawing
dome-shaped stations. requirements of density inspiration from several
| wanted to create an and affordability. | took photographs of Tokyo and
atmospheric landscape with my inspiration from Rio’s Dubai at night. | fall in love
these strange, spiky rocks.” high-density slums.” with anything that has an

# IasiierX July 2018 Want to submit your work? Visit http://ifxm.ag/getinifx
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3D is perfectly suited to Houston
Sharp’s line of work. “You can
reach a photo-realistic image
much quicker with 3D,” he says.

ARTIST NEWS, SOFTWARE & EVENTS

AT THE CORE OF THE DIGITAL ART COMMUNITY

magmeNation

th 3D software?

Added dimension Is mastering 3D software the key to artistic success, or does
it have its limitations? Dom Carter speaks to artists about their experiences

Art software has revolutionised how
illustrators create 2D work, thanks to
features that give users greater
control over their creations.
Alongside these tools, software
tailored towards 3D art has also
changed people’s creative ambitions
and opened up new career
opportunities. Yet, despite the two
disciplines having skill sets that

overlap and feed into one another,
some artists have initially struggled
to move between 2D and 3D.

Even a relatively early introduction
to animation and motion graphics
software Maya 3.0
couldn’t help it click with
Imaginism Studios co-
founder Bobby Chiu.

“It didn’t really feel like

July 2018

sculpting to me back then,” says

the concept and character designer.
“It wasn’t until 2017 when | asked a
sculptor friend of mine, Justin Goby
Fields, to put together an introduction
to ZBrush course for artists that

66 It wasn't until recently that
ZBrush made sense. I've been
learning it ever since... 99

Philipp Scherer says
there will always be a
place for concept
artists without 3D skills,
but observes that,

“I would estimate

that 70 per cent of the
concept artists | work
with use 3D software.”

ZBrush finally made sense to me.
I’'ve been learning and using ZBrush
ever since.”

For 2000 AD artist Thomas Foster,
picking up 3D software
skills helped improve his
confidence in creating
realistic backgrounds
and vehicles. “Upon
discovering SketchUp, | spent 3



WATCH FILMS —
PLAY GUITAR... RRStCEelF]

Giuseppe “Peppe” a
Cristiano opens the
door on his expansive

studio, which contains
a helluva lot of films
and an impressive
collection of guitars.
Page 26

“As an artist, you'll benefit from
knowing and using 3D because
everything you build in 3D can
be used in combination with
anything else, like digital
kit-bashing,” says Bobby Chiu.

There’s no right orwrong way to pick up 3D,
according to Steveé Argyle. “Every artist’s need
different. These days, specialising is often more
advantageous than being a generalist.”

WRITEINTO
IMAGINEFX!

Got something
art-related you want
to get off your chest.
Or want to make your
views heard about the
magazine? Then drop
us a quick line today!
Page 31

Thomas Foster thinks that, “3D
posing software can increase an
} artist’s grasp on lighting,

.» Composition and ‘camera’
placement - the better to create
dynamically directed scenes.”

INDUSTRY INSIGHT

HOUSTON
SHARP

The concept artist shares how to
learn the fundamentals of 3D

13

Yy o )

L e

Should artists learn 3D after 2D?
It's a good idea to learn the
principles first and the tools later,
otherwise there’s a risk of
becoming dependent on the
tools. It’s like building a flashy
house on top of bad foundations.
There are plenty of 3D concept
artists who can't draw or paint,
and that compromises them
when they're asked to quickly
sketch something out, or make

a certain mood/composition.

If you're confident in your
foundation, then learn that new
tool. If not, it's probably better to
hold off until you are.

Are there 3D expectations for
artists joining a studio?

It's definitely better to have some
knowledge of it going in. If the
studio or client is expecting you
to fit within their design team,
who uses a lot of 3D, it'll be an
issue if you can't keep up with
them. But concept artists aren't
modellers and asset builders,

so sometimes just a rudimentary
knowledge of 3D is enough.

Are there cost-effective ways
to pick up 3D skills?

I can't think of a single 3D
software that doesn't offer trial
versions of their software, so
that's a good place to start if
you'e too new to know if you
want to commit. Some software
even have simplified versions of
their paid counterparts. If you
can't afford ZBrush for example,
Pixologic offers a free digital
sculpting program that's similar
to ZBrush called Sculptris.

Houston is a illustrator and
concept artist who's worked
on films including Wonder
Woman and Rampage.

www.houstonsharp.com

July 2018 lifidgiiieEX #



ImagineNation News

| Thomas points out that the —
i usefulness of 3D depends on the
i career route. “Those illustrating

| children’s picture books or

: working in portraiture may not

| see any significant benefit.”

“Designs that concept expected and working digitally is
artists create are meant mandatory,” the concept artist and
for one thing: to be built,” illustrator explains. “Even basic
explains concept artist knowledge of 3D tools can be helpful.

p and illustrator Houston | have friends working as 2D artists

| Sharp. “If concept artists can start that | that only know how to navigate in 3D

. 3D visualisation in the beginning and set up a basic render. But it helps
| design phase, it makes it easier for the them when they receive files from a

| rest of the team to understand what i third party and they’re asked to create

| needs to built. From there, the team i aquick painting based on a 3D model.”

66 The time spent on these 3D methods
' has improved my versatility and the
- range of resources at my disposal 99

can even take the 3D concept to use Phoebe Herring, a lecturer in game

i asa starting point for the final assets.” art at Falmouth University,
Despite its usefulness, artists are still agrees that 3D art is

i able to get work with no prior becoming increasingly

i knowledge of 3D software. It just vital for concept artists.

depends on which route “Clients are interested in

»> a lot of time designing background | AlixBranwyn says 3D
can be aninvaluable

elements from scratch, or utilising time and money saver. | you want to take. Philipp | the designer’s vision, not in waiting
existing assets in order to round out tz'ﬂl?g:ﬁi{g‘&gfg?er : B Scherer reveals that around for them to lay out all of their
my repertoire.” take some time for getting your foot in the vanishing points by hand.”

The further discovery of DAZ 3D, g‘r’tﬁ‘srts:’\';; ;‘:g;eatgli;g &l % door still remains the most She points out that physically based
which specialises in rigged 3D human don't do enough.” . difficult step to landing projects. rendering offers her students a way to
models, enabled Thomas to create full “If you’re working in the talk about materials that applies to
3D scenes with minimal modelling entertainment industry however, a both 2D and 3D art. “3D theoryis a
involved, before he even put pencil to | basic knowledge of 3D is almost great way to talk about this stuff, and

paper. “This meant | always had a solid
foundation on which to build my
images. The time spent exploring
these methods has greatly improved
my versatility and the range of
resources at my disposal.”

CAREER BENEFITS

The speed with which artists can lay
down ideas with 3D software makes a
proficiency with tools such as ZBrush,
Blender and Cinema 4D hugely

Houston warns that artists sheuldn’t
let 3D take over. “Your 2D skills are

desirable to clients - especially when it just as valuable - if not more valuable

-as any 3D program,” he says.

comes to concept art.

w lifiasimerX July 2018



students confident in 3D can mock up
quick scenes to check the way their
creations respond to the light.”

GOING IN HEAD FIRST

Phoebe adds that there are other ways
3D studies can push your 2D skills to
the next level. “Students often benefit
hugely from sculpting proportionate
human heads in ZBrush, even if they
never go on to do 3D character art.
The study forces a real understanding
of the way features fall on the skull
and reveals weak points for the artist
to work on.”

According to Phoebe, 3D knowledge
can’t exist in isolation. “It needs to sit
alongside rock-solid perspective,
anatomy and design skills. These
fundamentals are the real tricky things,
and nobody ever stops learning them.”

; Illustrator Alix Branwyn
also thinks that without a
certain level of 2D
understanding, 3D tools
can only achieve so much.
“I've found that a lot of the software
that’s used for posing figures often
leaves an unrealistic feel that can seep
into the illustration and make it seem
‘off’. Faces feel lifeless and a bit
‘uncanny valley’, and hands often feel

Steve finds 3D useful
for roughing out a
scene. “You don’'t have
to model in every detail,
but if you have some
building blocks to work
with, everything
becomes easier.”

“Art is bigger than

the software and in
the end, artists should
remember that 3D
software is just a tool,”
says Bobby.

stiff and waxy rather than expressive
and fleshy.

“I look at the use of 3D the same
way that | view the use of photo
reference and 2D digital shortcuts: it’s
just another tool to get the work done
quicker and make it look good.”

Bobby is of the same mind. “If you
don’t understand art fundamentals,
3D won’t save you.”

WHERE TO START?

For 2D artists looking to add 3D to
their skill set, the range of tools
available can be an embarrassment
of riches. “Start small. 3D can be
overwhelming,” advises Magic: The

At Phoebe’s university, 2D is
taught alongside 3D. “I do
hear from some students
that it knocks their

. confidence at first. These
are often artists who

have always been

top of the class.”

Gathering artist Steve
Argyle. “One very good
way to learn 3D is to
commit to one piece

of software at a time and
learn the basics of everything it does.
Then go deep into whatever it is you
want to do with that software.”

If this sounds too much like hard
work, Thomas still thinks it’ll be worth
your time. “There’s virtually no reason
for artists not to learn about 3D. Even
if the conclusion they reach is that
it’s of no use to them, it will, at least,
be an informed conclusion. More
likely, they will come away with
another string to their bow.” g

July 2018 liviagiieEX #
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ImagineNation Artist in Residence

The room is spacious with high ceilings. The big

door leads to a corridor and some other rooms,and
the stairs takes you to the main part of the house. In

the corner | have my recording studio.
bedrooms are two floors above so | ¢
even in the middle of the night if | feel

| bought this Tintin painting in
Barcelona many years ago, and I've
had it in every studio I've moved to.

My small recording studio helps me to recover from
tight, stressful deadlines. Occasionally, | lay down some
tracks for my ongoing projects. I've made quite a few
records over the years, which are available on iTunes,
Spotify, Amazon and so on. Of course they won't sell so
I'll keep working on my storyboards.

| have a large collection
guitars and bass guitars. On >
this rack there’s one really
special instrument: a Gibson
Robot Guitar, which had a
limited production run of
1,000. It’s self-tuning and
based on a Les Paul model.

=

I’'m very neat and organised. | wouldn? eit
through the day if | wasn’t - especially when working
with creatives in the advertising business. I'm always
prepared on revisions and ready to go into meetings.
Everything | need is within reach. | work with three
screens and am ambidextrous, so | use. my left hand
for drawing and the right hand foreverything else.

| still carry around a sketchbook when |
travel, even though | love working
digitally. | like the immediacy and the
simplicity of putting marks on paper.

lifiasimerX July 2018
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Lillagrisen means “little pig” in Swedish, and-he’s my # i< Rrghiv. - w m ;
mascot. | carry this little piglet with mewhenil travel. 3
lusually post a photo of him on my socialimedia : -
when I’'m on the road. He has a lot of fans these days. % I
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| keep little toys and small
memorabilia that I've
collected over the years in

- B Giuseppe
IIP epp eII
{ ] { ]
Cristiano

Comfortably organised This artist
reveals that his studio is the place where
he wants to spend time, not just work

I’m Italian and as a young adult | left Italy
to find work and try something different.
| succeeded, and for the next 25 years

| worked and lived in Europe and the US.
Mostly I’ve lived in Stockholm, Sweden.

| recently moved to a new house with my wife and kid.

I’'ve taken over a couple of rooms on the ground floor as
my studio. It’s important for me to have space. In the main
room where | sit and work | have everything | need to
survive long, extensive creative sessions. In front of my desk
there’s a TV with different kind of play-back devices, even a
VHS player. When I’'m not in a meeting | can watch
something while | work.

In a corner of the main room is my recording studio and
collection of instruments that helps me de-stress every now
and then (I often jam with my friends in the garage). #»

In a corner is my

recording studio and

collection of instruments
that helps me de-stress. ..

My meeting room is also the place where | organise my work. Sometimes | do
exhibitions or write a book, and then | need a room where | can leave stuff around
for weeks. Behind the doors are shelves of comic books and all sort of stuff.

July 2018 lifidgiiieEX #



ImagineNation Artist in Residence

This big print was a leftover from one
of my exhibitions. | use it when I do a
presentation because I'm still fond of it.

My wife gave me this big pig’s
head for my birthday a few years
ago and it was so heavy that it
broke the baby stroller she used

tocarryithome. e

#> Next to that | have a meeting
room that | also use as a reading room
or place where | can organise my
exhibitions or works in progress.
Because | always have several projects
going on at any time, the space there
is absolutely vital for me so that | can
leave my art there when something
else needs my attention.

NOW SHOWING....

| have a very large film collection - it’s
probably close to 20,000 titles these
days. And it’s still growing. | use the
other rooms at my disposal as storage

| like to browse through records every time I'm
at a second-hand market. The Jaws soundtrack
is signed by Steven Spielberg.

/

| have far too many pillows, | don’t really need
that many but | always find a new cover that

| like. Now | keep them on rotation, just to
change the vibes in my studio a little bit.

for my work materials, prints,
magazines, folders, all sort of papers,
canvas and computer equipment. | like
to be well stocked.

On the walls around me | have
inspiring works, prints or pictures of
artists who | admire and that I've had
the fortune to meet over the years.

I’'m a early bird and | usually wake up
at 5:30 to have a coffee. My son (who'’s
three-and-a-half years old) seems to
have taken after me so as often as not
we spend that moment together. If my
wife and son isn’t up at that time then
| usually begin work. If | don’t have any

66 One of my most important routines is
that I always do at least one illustration
just for myself each day 99

liiasierX July 2018

| thought Framing Films sounded cool so |
printed a lot of small gadgets with the
phrase. It’s also the title of my next book.

| collect and buy art

books | find interesting.

I’'m curious by nature
and | always do
research and find new
inspiration. Not just for
work but for my own
interests and projects.

This wall is covered by signed work from
my favourite artists, which include Moebius,
Bill Sienkiewicz and Will Eisner.

/

i

That is the corner where | spend
most of the day using a small
tablet. Occasionally | move out
of the room and work in some
other part of the house.

work from the night before | take my
coffee and spend some time updating
my blog, social network, posting
images and answering emails I've
received during the night. When they
wake up | join then for breakfast.

I've developed and mastered certain
routines over the years and | use those



quiet morning hours for my own
projects. They’re very important to me.
Of course, depending of the meetings
scheduled for the day, my available
free time varies. One of my most
important routines is that no matter
what | have on my desk | always do at
least one illustration just for myself
each day. It can be anything, from a
sketch to a finished picture.

BALANCING WORK AND FAMILY LIFE

At around 9am people usually are at
their offices and my working day
begins, and it sometimes ends at crazy

hours since | also have clients overseas.

| usually try to finish the advertising
jobs that comes in by the evening.
| don’t like unfinished things since |
never know what the next day might
bring me, work-wise. And of course,
having a family means | want to spend
as much time as possible with them.

For many years now I’'ve mostly
worked from home. Occasionally | fly
for a few days to meet directors for
longer or bigger jobs, but we usually
continue working over Skype for the
following weeks.

| started up professionally in the
early 90s so | work both traditionally
and digitally. When | travel | carry a
Wacom MobileStudio Pro. | try to be
up to date with my kit and | leave my

Artist news, software & events

| can’t work without music, which is also a passion of
mine. I've made a few records over the years and

| used to play in different bands. Time is a bit limited
now, but I’'m still working on new projects.

previous or older screens at places
that | visit often, such as my parents,
because | sometimes get jobs with
only a few days’ - or hours’ - notice,
and always with tight deadlines.
Giuseppe is a former comic artist and
scriptwriter who's been drawing storyboards
for more than two decades, as well as
freelancing for advertising agencies and film
production companies. He's also written and
published several books and manuals and
occasionally gives lectures and workshops.
See his art at www.framingfilms.com.

Part of my film collection. There’s
everything from documentaries,
classic movies, VHS, DVD, Blu-ray
and TV series. You name it,

| probably have it... somewhere!

| collect all sorts of pigs. My friends
know this so you can guess what
| usually receive as gifts!
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Letters
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L ette rS ‘e %l New works that have
YOUR FEEDBACK & OPINIONS | § s grabbed our attention

Contact the editor, Claire Howlett,
on claire@imaginefx.com or write
to ImagineFX, Future Publishing,
Quay House, The Ambury,

Bath, BA1 1UA, England

Follow us on Twitter:
www.twitter.com/imaginefx

n Tell us your thoughts on Facebook:
www.facebook.com/imaginefx

... while Oslo saw the Q&A section as an opportunity to
+ solve readers’ art problems almost as they happened.

contains quick tips aimed at specific

| issues, almost like a call-in help section.
' Itseems about as ‘live’ as a magazine

| can get: it connects the readers directly

' to the artists. I like seeing the ‘yeah, T

- had that issue too, and here’s what I did
- to solve it’ from some of the world’s top
. artists. And it covers such specific issues
. that may be glossed over in a lengthier

| article. It's a great feature in a great mag.
| Oslo, via email

@ Post your art or photos on Instagram:
www.instagram.com/imaginefxmagazine

Never liked Q&A - =
I felt compelled to write in after | =—cur
reading the feedback from Thilo
Schon about the Q&A section of the
magazine being on hiatus. Its removal
struck me as a good idea. I always felt

f;j Maria Becvar
4 @becvardoodles

| Claire replies I can't win, can I! Thank
| you for your comments Oslo, sorry to have
the section was too specific to be of | let you down. Q&A has taken a back seat
any use to me, and likely other readers. ' for a while, but that's not to say it won't

Ialso feel like readers who write in | ===

| come back. For now, I want to give more
to complain about the traditional

section are missing the point that these
also inform digital techniques or often
feature skills that are beneficial to every
artist, regardless of the medium.

To finish off with some praise, I love
your magazine. It's always fun and
inspiring to see the different styles and
themes represented. I learnt a lot from
Stan Prokopenko’s recent article and
from a feature that discussed values. [
loved discovering Simon Stahlenhag's
work, and even noticed him featured by
other artists on Twitter after that issue,
which is likely not a coincidence. It's
great that amidst social media and the
internet as a platform for sharing art,
your magazine still has such an impact.
Gemma Gahan, via email

Claire replies Gemma, thanks for an
insightful run-through of your thoughts on
the magazine. As for having an impact, I
can only say that we love finding different
artists, themes and skills to share with you,
50 I can only hope our enthusiasm shines
through. Lots of artists say they get amazing
feedback from their peers for appearing in
the magazine. That's always nice to hear.

I miss Q&A!

[ wanted to weigh in on Thilo’s letter
from the May issue on the Q&A section.
I'm also a big fan of this section. It

Gemma felt that the QRA
section covered topics that
were too specific for the
majority of readers. ..

Don't worry — you
can still get hold
of it. Visit http://
ifxm.ag/161-ifx
for details.

- | Toom to interviews and other features, too.

Does anyone else have thoughts on the

i balance of contents within these pages?
i Let me know.

' You can't beat traditional

- Ifound your magazine around the same
time as I started getting serious with

. Photoshop. I still rely almost totally on

. Photoshop and ImagineFX to work out
new ideas and compositions.

When it comes to the execution of

. one of those compositions, however,

' I move over to my traditional art setup.

i Ilove making a big mess when I try to

| createvisual art. I can put a work-in-

. progress up in the hallway and critique

. it whenever I walk by. When an oil

. painting is done, I can grab hold of it

- and even look to see what's on the back.

Please keep at least the same

proportion of traditional arts in your
| excellent magazine.
| Jerry Smetzer, via email

| Claire replies I'm glad to hear that our

' relationship is still going strong, Jerry. Thank
' you for sharing how you create - I love

- hearing how different artists use the tools

- around them to make art. Your process

| reminded me of Erik Jones, our last issue's

| cover star. Readers, please share your artistic
| process with me - you might inspire a reader
| to start a new way to paint.

O] Umut Diilger
“4 @magaraduvari

If you have created art that you want us to
shout about simply tag us on Twitter or
Instagram, or find us on Facebook!
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~ 2518 STUDIOS

Art by Mark Makovey, 5518 Studio’s
senior 2D artist who'’s based in

St Petersburg. He was inspired by the
latest Pirates of the Caribbean film.

Based in America and Russia, the art production company tells
Tom May how they create a range of art for the games industry

. oday’s globalised game
industry is an increasingly
24/7 world. But 5518
Studios is one art
production company that has
no problem offering a round-the-
clock service.
With studios in Ulyanovsk and
St Petersburg in Russia, and a
headquarters in Los Angeles (the latter
two are 5,518 miles apart, hence the

Studio

PROFILE

w lifiasimerX July 2018

| name), it's able to work continuously
on time-sensitive projects across

. multiple time zones. And that's helped
. the company carve out a strong
reputation for supplying concept art, _
- illustrations, 3D modelling, animation, |
- cinematics and augmented reality/
- virtual reality to the games industry.

Furthermore, there’s another way
they're disrupting traditional business
models. As 5518 Studios states on its
website, “We are not outsourcers, we
are external partners.”

Founder and CEO Michael
Casalino, who's based in the LA office,
explains what that means
in practice. “We want to
be a true extension to the
team, so we don't like
calling the people we
work with ‘clients’; theyre partners.

| And we want, ideally, to be integrated

Michael Casalino says
i thatit was a “big
. privilege to work on the

iconic Snoopy universe

. torecreate famous
| characters and worlds
i for next-gen devices.”

. fully into their process and pipeline,
i whether that's their Skype, their Slack,
i their Trello, their Jira or whatever.”

Since 5518 Studios’ launch in 2016,

it's worked on more than 15 such

| partnerships with the likes of Google,
| UBER, Wargaming, Scopely, Oculus

| VR, Warner Bros. and Electronic Arts.
| Headline projects have included



Studio Profile 5518 Studios

Sci-fi military character
concept for agame
that’s coming out

later this year on

Xbox and PlayStation.

This is early 2D concept
art for a VR experience
in a museum exhibit to
be shown in New York.

A product review session with
the team in St Petersburg.

Anin-game illustration for Is It Love?, the hit mobile title that’s
published by 1492 Studio and Ubisoft.

July 2018 lifidgiiieEX #
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Michael says, “We wanted to
imagine how VR could be used
in a mythological setting. Turns
out it can be very scary!”

work on Walking Dead: Road to
Survival, WWE Champions, Family

SMITE, Snoopy Pop, World of Tanks
HD, Rune: Ragnarok, DICE with
Buddies and Wheel of Fortune.

As of necessity, the art produced by
the studio varies in terms of style. But
what remains consistent, Michael says,
is “high-quality detail in 3D character
modelling. A lot of that starts off with
strong 2D concept art, and then we

take that flat image and bring it to life.”

i Inspired by Horizon

| Zero Dawn, senior 3D
i artist Sergey Tyapkin
! created arobotic

Guy, Temple Run, Striker VR, Paladins, |

mammoth for an
internal R&D project,
later to be used by
Allegorithmic to
promote Substance.

86 It starts off with strong 2D

concept art, then we take that

image and bring it to life 9

July 2018

Most of the studio’s artists are either

i 2D or 3D specialists, although they're
: sufficiently informed about each

i others’ disciplines that they can

i collaborate closely, Michael adds. “So
| if, say, we're missing details in the 2D
| concept art, the 3D artist will say,

| ‘Okay, where do you see things from
the concept side happening on this

i scene over here?’ Then they’ll work

i hand-in-hand on patches.”

i There have been so many 5518 Studios |
! projects that hard to know |
exactly where to start. But
one that's at the forefront
of co-founder and COO
Maxim Miheyenko's

i mind right now is its recent

partnership on World of Tanks HD.
“It was a big challenge involving

physically based rendering art and

real-time physics,” explains Maxim,

| who's based in the St Petersburg office.
| “We worked very hard with Alexey

| Nazarov, our art manager, and a great
team of artists to create next-level,

| realistic art for Wargaming's well-

i known blockbuster.”

Another project is a mobile game

called Snoopy Pop, where the studio
i has been working with gaming

company Jam City and the Charles

Schulz Group. “All the whimsical

| 2D artwork we're doing for the

| backgrounds, the iconography, is all in
! line with the original Peanuts
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FEDOR LOSEV

The 3D character artist on
the appeal of the unknown...

How did you come to work at
5518 Studios?
After studying fine arts, |
worked as a 2D artist in
different game studios. |
developed my skills in sculpting
and low-poly modelling as a
hobby. | came to 5518 Studios in

: 2017 because | really wanted to
This is an in=game screenshot from work on Battlefield. | met co-
the mobile bloekbuster title Snoopy founder and COO Maxim online,

Pop that 5518 Studios worked on.

and soon tons of work came

flooding my way.

Allrights reserved Jam City

What kind of art do you create
in your job?

I work on sculpting, low-poly
and texturing, including organic,
hard surface, characters

and props, mostly for
photorealistic projects.

How does this differ to your
personal art?

| like to design 2D original
creatures. | think some of these
have migrated into my 3D work,
but I'm always researching new
shapes and new approaches in
my personal work. | try to find
something unknown and then
bring it to life.

What have you been working
on lately at 5518 Studios?
I've been creating some exotic
and unigue hairstyles for next-
Dragon concept art created generation, physically based
for the open-world sandbox . .

game Rune: Ragnarok. rendering characters. This has
been a real challenge for me,
because | haven’t done such

complex hairstyles before.

5518 Studios created this promo
art for SuperSenso, an innovative
RTS game for the mobile market.

SOIPMIS iOGYN L/IUSWIUIRLISIUT BUIIUQO OHBUND PaAISSal SIUBU ||y

What advice would you give to
a young artist wishing to work
at 5518 Studios?

Research new tools and
technigues that will improve
your work and time. And don’t
forget to go out and relax, and
also do some sport - that’s also
very important!

Senior character 3D artist
Fedor is busy working on a
range of epic characters for
Rune: Ragnarok.

www.artstation.com/feddark

July 2018 lifidgiiieEX #
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» artwork - and even as I'm talking
to you, I've just got chills,” says
Michael. “I mean, when I was nine
years old, I used to draw Woodstock
and Snoopy all the time. That we're
working on this iconic brand... well, I
can't quite believe this is happening!”

With more than 60 artists typically

working on 12-15 projects at any one

time, 5518 Studios is certainly a busy

place. But the hectic pace is balanced
out by a positive and
nurturing working
environment, says art
production manager
Elvina Antonova, who's

based in Ulyanovsk.

“There’s an informal and creative

atmosphere, with a lack of unnecessary |

bureaucracy and pompous meetings,
and we feel like we're one big family,”
she says. “Things are run in a similar

way to a company like Google, where

W lifiasimerX July 2018

. people are encouraged to develop their
i creativity, initiative and talent.”

Most of the artists working in

. Ulyanovsk and St Petersburg are

. Russian, along with some hailing from
- Asia. But 5518 Studios also employs

- large numbers of freelancers, working

| remotely from around the world.

Elvina has the following advice for

any artist wishing to work with them

| “Be ready to learn fast, improve your

| professional skills every day, and never
| give up. Play as many games as

-8 That we're working on this

iconic brand... I can't quite
believe this is happening! 99

Art for Toontastic:
Cars 3, an education

app by Google. Michael
i new techniques as you can.”

says, “It was a big
pleasure to work with
Thushan, Andy and
all of the Google team

| possible. Learn how to use Al tools for
| artists, Substance, Maya, ZBrush, 3ds

Mazx, and get to grips with as many

Michael agrees that technical skills

| 5o bring Cors oo ehidren | ATe vital, and need to be constantly

| around the world.” . refreshed, “Our artists have to be ready
! to reset their skills every year, with
! every new update,” he says. “But that

| shouldn't take anything away from

your passion and creativity.
“Here at 5518 Studios we tell stories
in every detail of our art. We don't

| just create art from polygons and
| textures, but also try to fill it with

life, real history and love. That means
being pumped every day, non-stop
- we wake up and run to hunt for a

| new mammoth!” g
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Alexander Stepanchikov,
the studio’s lead 3D artist,
created this orc to teach
himself the new version
of Substance Painter.

5518 Studios often plays around 4 Michael with Maxim, the two
with some popular iconic game i founders of 5518 Studios,
screen shots, adding some new pictured together at XDS 2017

fresh IP to them. in Vancouver, Canada.

This Illustration by Mark Makovey
was created entirely in Alchemy.
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PABLO
(ARPIO

—

From having no job to working for Disney
and Marvel - Gary Evans learns how this
artist’s Hollywood gamble paid off...

ablo Carpio had a plan.
He'd use the money he put
aside for university to pay
for a trip to Hollywood. The
young concept artist would then
go to all the big studios, meet all the
right people, and get his big break in
the film business.
The Spaniard touched down in Los
Angeles. Reality hit. He was alone and
had no idea where to go or who to see.

Artist

PROFILE

Pablo Carpio

LOCATION: Spain

FAVOURITE ARTISTS: Edward Hopper,
Caravaggio, Rembrandt, Francis Bacon,
Asher Brown Durand, Frank Tenney Johnson

and Jeremy Lipking
SOFTWARE USED: ZBrush, Cinema 4D,
OctaneRender, Photoshop

WEB: www.pablocarpioart.com

# lifiasimerX July 2018

He needed help. Pablo called up a few
people from the digital art community
- artists he’d met online and at events.
They called up friends, who called up
their friends, and pretty soon he had a
meeting at game developers Naughty
Dog and Riot Games. Then Pablo
found himself in Burbank, at the
headquarters of Disney Studios.

“At that point I didn't have any job,”
he says. “Three years later I've been
involved in the creation of three films
from Disney’s franchises.”

Pablo grew up in an upper-middle
class family in Madrid. He described
himself as a rebel without a cause -
until he found art. People noticed
he could draw, so he worked at it. The
more hours he put into art, the more
people noticed.

“It was just me having fun and
having the curiosity to know what »»

(OMFORT ZONE

“I would say that this painting is totally
inside my comfort zone: orange tones,
sunset light and a Western theme.”




[nterview Pablo Carpio

STARSHAPES

“This is a painting from almost three years
ago, but it was a big step for me! I tried to
design a new spaceship for the Star Wars
universe that could be a mix between Boba
Fett's Slave I, and a Nubian Royal Starship.”

At that point I didn't have
any job. Three years later
I've been involved in the
creation of three films from
Disney’s franchises

July 2018 liviagiieEX #
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TRIBUTE

“This was a gift for a friend to use it
for his magazine cover: a tribute to
Mark Maggiori's Western landscapes.”

=+ would happen if I could do it a bit
better the following day,” Pablo says.
He painted Warhammer miniatures,
drew copies of the characters from
Magic: The Gathering cards, and got
into gaming during the PlayStation
and PlayStation 2 eras - playing
games like Spyro, Tekken and Crash
Bandicoot. His art improved, but his
schoolwork suffered. “Most people
around me thought that I would end
up living under a bridge if I kept
painting, and not doing anything else.”
After high school, Pablo studied fine
art at the Complutense University of
Madrid. This wasn't like school.
Instead of maths and physics, it taught
sculpture and art history. He excelled

* magieX July 2018

at his studies. Pablo grew up in an
environment that valued a university
education, so when he graduated
in 2014, it earned him some respect.
It didn't last long, though. That same
environment also valued money. “The
idea of being a successful artist was
basically nonexistent among my
friends and family.”

At university, he got into digital art.
All those miniatures, trading cards,
computer games — somebody had to

HIDDEN DEPTH

“While working at
Marvel I started pushing
my 3D skills way more
than before, trying to
create different characters
just as a training exercise.
This is one of them.”

66 I discovered they were
designed by real human
beings, not by ancient gods

draw them. “I discovered they were
designed by real human beings with
a salary, and 20 days of holidays a
year! Not by ancient gods that had
brought them as gifts from the sky.
Suddenly, painting and designing
monsters had a real purpose. I had an
objective for the first time in my life.”

ZERO IMPACT

Pablo spent several years trying and
failing to break into the games industry.
There were lots of rejections. People
tried to make him work for free, even
steal his art. He wanted a job at a small
independent developer, or even a job in
game publicity or advertising. “My
expectations weren't higher than »»
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PERFECTLY COMPOSED

Pablo explains how he uses light and colour to lead
the viewer’s eye and create a strong focal point

“This is a painting that | did last year,
inspired by Syd Mead’s work. | tried
to make a composition with a
definite focal point, which can be
tricky because symmetrical shapes
tend to make images less dynamic.
As always in my work, | start with
a 3D base, throw in a render for the
main light and colour, and then paint
over it later in Photoshop. My idea
was to use colour to hide the
guidelines, and light and shapes to
push the composition. If you link the
heads of the characters, you unveil
an arrow pointing to the ball in the

.
A=
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BRINGING A COMPOSITION T0 LIFE

-
e

[

“I love working up the composition, colour and light. Keyframe and environment work appeals, too,
so in my personal work I try to make all these factors work together.”

middle of the image, which is the
focal point.

The repetition of the light and its
direction is supposed to give
narrative structure to the image,
leading the eye from right to left, as
it travels from the vehicle to the guy
in red, and from the guy in red to the
ones who are receiving the offering.

The colour scheme is basic, so
it clearly separates the characters.
One side of the image is white and
the other red, and the ball is the only
object in the composition that’s a
different colour.”

DEVELOPING A STRONG FOCAL POINT

-} .

N -
>
THE LONG ROAD TO ARTISTIC SUCCESS

—
.-

inspiration for this:piece. Tl;é'%\’xn’gmn

* THE OFFERING

Veteran artist Syd Mead was Pablo’s

~ s best known for his concept w kon
films Blade Runner, Aliet?s and TRON.

Pablo loves employing circles in his work. The artist uses them as the key focal
points, around which the action in the composition takes place.

Pablo spent five years creating and sharing pieces like The Offering before he received any interest
from video game companies. But all that hard work and determination has finally paid off.
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»» that,” Pablo admits. “The beginning | digital art community. He went . INSPIRED BY i Creed franchises invited him to work
was tough: no contacts, almost zero i to events and met them in person. NASTASIA i as a freelance concept artist. “I signed
impact on social media, and zero trust ;  “I started to understand how the IL ’:{::;‘fig(‘f}":g";é‘; m | thecontracts and two days later I was
in myself and my abilities.” i business works, and how big video Berlin. I took inspiration | working on a AAA video game.

It caused problems with his family. | game companies and movie Jrom some key scenes in | Sometimes reality hits you like a truck.
After several arguments, they agreed ~ : productions were not that far away. film Anastasia.” | Butin a good way.”
to let him stay at home without getting : It was just about pushing your skills :
a “real job.” Every day for the next i to the limit and knocking on the right | CONCEPT ARTIS IDEAS
three years he worked on his art. i doors at the right time.” | Pablo works in both 2D and 3D. He
He drew and painted and hoped an ! Finally, Ubisoft Montreal emailed. | | has a simple setup: a tablet, laptop and
opportunity would eventually come . The game developer behind the Far | monitor. The average piece takes him

his way. He made friends in the online : Cry, Prince of Persia and Assassin’s | three days to complete: a day for

#6 The beginning was tough: no
contacts, almost zero impact on social
media, and zero trust in myself 99
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DEMACIA sketches and 3D layouts, a day for

“Another painting from
the series for League of

. Legends, of the Demacia
i landscape. I tried to

adapt the colour and
lighting to previous
concepts created by the

detailed 3D modelling and light
| rendering, and another for
| photobashing and 2D painting.

He prefers 2D for concept art, but by

i working in 3D, he can produce lots =
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BRAVE NEW WORLDS

“Since I was a child, I was attracted
to the idea of translating thoughts
into paintings. I had the urge to
make real all the ideas and worlds
that I was building on my mind.”

ANEW VIEW

“This painting was a way to learn about
scale and distant points of view, because
these are topics I rarely tackle in my art.
used grey and a diffuse lighting scheme
to achieve a more moody-looking scene.”

P e LT LT
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Artist Portfolio

SILVERA

The French band Gojira sang about
“dead bodies falling from the sky” in
their song Silvera, which provided Pablo
with a key moment of inspiration.

GETTING DEEP

“This was an exercise in

storytelling to say something, to
convey an idea. “Concept art is all
about ideas,” Pablo says, “not amazing
renders with tons of effects.”

The Spaniard’s work shows us

»» of images very quickly and very
accurately, which is important in game
Y . P .. 8 depth and scale. I was
development when time is tight. For inspired by the art of Nick
him, the idea is always more important | Gindraus for Uncharted
X 4, which is one of my
than the medium.

favourite video games.”
There’s a difference, the artist says,

between drawing something just
because “it looks badass” and drawing
something because you want to
communicate. And this is what great
concept art should do: use design
language, shapes, composition and

%6 Concept art is all about
ideas, not amazing renders
with tons of effects 9

“I use 3D modelling to -
createa

illustration.

a first render asic

lights and colours, then
move into Photoshop
where I both paint and
photobash the image.”

something happening, action, a
moment in time. His composition
gives us clues to what's going on. He
believes that a varied palette of colours
keeps the viewer interested. And he
uses light to create mood and to guide
the eye around the image.

“Apart from all of that, I love circles.
Sounds weird, but you can see that
all my images have circles somewhere.
I think that it's a shape which can
bring lots of balance, thythm and
weight to designs.”

Pablo has just completed work on
movies for Pixar and Marvel Studios
(unfortunately, he isn't allowed to tell
us which ones). Working in these kind
of collaborative environments meant
that he had to adapt his ideas to fit the
given project, the budget and the rest
of the team.

The projects posed questions, and it
was his job to come up with answers.
That, Pablo says, is what a concept
artist does. It's not just about making
nice pictures. In return, he learned
countless new processes, techniques
and tools to use in his work.

THE VALUE OF GOOD IDEAS

Something Pablo found difficult was
giving away his best ideas. He
instinctively wanted to keep them back
for personal projects. “In the end, I
gain more by giving my best, rather
than keeping it all to myself and
delivering only half of my potential. It
shows that I'm a reliable artist, which



will lead to good words from my
clients that can potentially introduce
me to new projects and directors.

“The result? A happy client and
the chance to leave my mark in a
Hollywood production.”

Which finally brings us full circle -
Pablo’s very own Hollywood ending.
Dropping everything, flying out to
Los Angeles, hoping to make it in the
film industry despite not having a
single meeting lined up... looking
back, that was a bit of a mad idea,
wasn't it?

“It’s all about always moving
forward,” he says. “It's about risking
what you have and believing in your
own abilities, and if you don't have
an opportunity, create it by yourself.
Making things happen starts by taking
bold decisions.

“I happily look back and realise that
it wasn't as impossible as it looked
when I was still painting on my maths
book at high school.” g

[nterview Pablo Carpio

ANOTHER DIMENSION

Pablo explains why he doesn’t differentiate between using 2D
and 3D techniques when creating his concept artworks

“| recently did a personal piece called Silvera.
It’s in honour of a song by the French band
Gojira. The song inspired me to work on
character design - something that | don’t do
frequently. | also took inspiration from the
Christian folklore celebrations that happen in
the south of Spain during Easter. It’s a weird
mix, but | had a lot of fun working on it.

A piece like this can take around three days
to finish: one for drawing sketches and
creating a 3D layout, another for detailed
modelling in 3D of the base and rendering
of the light, and then a third one to paint in
2D and apply some photobashing.

| like working on 3D more and more every
day. Because I’'m always improving, it offers
me new options and points of view to
develop my pieces. 3D is very important
in a production pipeline for delivering high
amounts of work in a short period of time,

and at the same time to provide
mathematically accurate light conditions and
colour, especially if the work is going to be
used for movies or games that need a
realistic look.

However, as a concept artist, normally you
deliver your work in 2D, so it’s important to
also have techniques like photobashing and
speed drawing to be able to show things
done in very short periods of time.
Sometimes preparing 3D is too much work
for a morning, so you need to jump directly
into 2D to be able to demonstrate certain
ideas quickly to your clients.

Of course, 2D and 3D require different
skills but what matters in the end is the vision
of the artist, and how they control the space,
the light and colour. In the end, there’s no
difference between charcoal or digital VFX
when it comes to creating original art.”

July 2018 Iividgiie X %
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here’s how you can order yours today!
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Bastien Grivet

LOCATION: France

Bastien’s a Swiss art

) director, concept artist

. and composer who’s

. based in Montpellier,
southern France. He co-

founded Wardenlight Studio with his
| wife Jessica Rossier and has worked

on various big productions around the
world such Call of Duty: Black Ops 3,
Shadow of War and the upcoming
Spider-Man: Into the Spider-verse.
www.grivetart.com

SPACESHIP!
SPACESHIP!

“This is just a tiny sample of the
hundreds of pages that I've filled
with various shapes and
experiments on the theme of

sci-fi flying designs.”

ANGULAR
EXPLORATIONS

“Here is a good example of my shapes
experimentations. Zaha Hadid has always
been an amazing visionary for me, but
also straight lines from artists such
Ralph McQuarrie and Doug Chiang
have always been in my panel
of inspirations.”
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TOWER
GUARD

“Drawing buildings and structures is a
good way to play with rhyme variations
in my shapes and lines. | always try to
use some non-repetitive stroke
lengths and various structured
plain and empty shapes.”

I spend every second
of my free time sketching
whenever possible...
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CONCEPTS

“A fun art task to do is to play with
contrast in terms of context. An
old barn fitted with crazy sci-fi
devices, for example...”

CARGO I

“Flying boats are like iron
clouds... Right?”

“I spend every second of my free time
sketching whenever possible: when I'm stuck on a train
or plane, or while I'm waiting for someone. But it has to be a
nice place. Give me a small coffee table with a warm cappuccino
and the world can fade away. You'll never see me draw in a
crowded fast food joint or in a dentist’s waiting room (it’s
hard to draw with a trembling hand).”
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“I love to use brush pens,
—_ which create lovely, soft— .
values. Here, | took an
‘M“\ empty brush pen and
filled it with water and
a few drops of ink.”
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Bastien Grivet

HIGH
CITADEL

“I've always loved drawing mountains,
futuristic buildings and spaceships. But
someone once asked me: “Hey, why don’t you
draw something else like characters, you lazy
so-and-so.” And like every artist | felt guilty sticking
to one or two subjects. But it was what | loved to do
during my free time, so | said to myself: “l don’t
care, I'll draw in my sketchbook only what | love
to draw and I'll be good at it.” I'm still learning
alot, but it was one of the best decision in
e my life. This sketch was the first one

based on my promise.”

o SHAPES
= AND SPACESHIPS

“Another good exercise for me is to play
with a vehicle’s shape and the way light
and shadow interact with it.”

%6 I'll draw in
my sketchbook
only what I love

to draw... °°
N -

July 2018 Iividgiie X #



TWO MAGAZINES e
IN ONE! o

SUpermarkets
-‘--‘-‘-"""‘--_

: S0DN )
gmmaﬂmnf N

" SPECIAL / THE 200 GREATEST GAMES
_EDI TION! | OF ALL TIME - BONUS MAGAZINE

Available at www.myfavouritemagazines.co.uk

ON SALE NOW

ﬁ facebook.com/gamesTM y twitter.com/gamesTMmag



Workshops assets

NOL T FOR DIGITAL ARTISTS - are available...

magine’
Workshops

AdVice from the world’s best artists

page 8. And if you see the video workshop badge,
you can watch the artist in action, too.

Plan and paint
a striking figure
Even Mehl Amundsen solves
lighting and anatomy issues.

Quickly work up
a 3D concept
Adam Dewhirst models a
forest creature in ZBrush.

Core Skills:
Photoshop
Make the most of the mask
tools with Mark White.

15 sure-fire ways
to get motivated
Follow Mel Milton’s tips for
enhancing your productivity.

Model a scene for
a paint-over
Ara Kermanikian creates a
3D sci-fi composition.

Character
creationin VR
VR skills with Glen Southern.
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Workshops

Photoshop

PLAN AND PAINT

A STRIKING FIGURE

Learn how Even Mehl Amundsen solves lighting and anatomy problems
as he paints a female character that’s been inspired by tribal elements

Even Mehl

Amundsen
LOCATION: Norway

Even’s a freelance
concept artist and
illustrator based in
Oslo. His main fields of
work are games and
animation, where he
creates characters

and builds worlds.
http://ifxm.ag/evenma

&, REsOURCEs g
ORKSHOP'
BRU

PHOTOSHOP

CUSTOM BRUSHES:
AUFGENOMMENER
PINSEL 1

This slightly textured
chalk-style brush is
my go-to tool for most
painting needs. It’s
very versatile.

SUBTLE COLOR
RANDOMIZER

This brush can be used
for some subtle colour
variation, as well as

knocking back or even
removing sharp edges.

ROUND HARD 701

The old Round brush can
pretty much be used

for anything, especially
when drawing lines.

Doing the course of
this workshop I went
through some pretty
well-established steps
from my creative

process, which can be applied either
to character work or more elaborate

llustration work. Indeed, my aim
was to focus more on the chosen
subject matter than on technique.
However, it turned out to be more
of a lesson on why it’s so important
o spend enough time on planning

| out your pieces properly, so you don't

| have to spend your time fixing
mistakes later on. A job with even the
| tightest of deadline is manageable if

| you put in a basic amount of ground

. work. So come along and learn some
' dos and don'ts, and check out where

| I nearly mucked things up big time!

Initial character ideas

After I receive the brief and collection of reference
material, I work up a very basic sketch. The ImagineFX
team has a pretty clear idea of what they want for the
piece, so for the technical aspect it's more about making
something interesting out of some subtle character
nuances. That turn of the head, the crook of the smile, the
eye contact. These gestures will eventually play a pretty

central role in selling the image.

# lifiagiieX July 2018

Key shapes and tribal elements

I have a good idea of what I want to do with the
figure and her pose, so I sketch it out. I focus on the key
details and overall shapes that would both work well and
enable me to show off some interesting tribal elements.
After I send off my sketch, I receive an edit for the angle of

the face, but the rest of the details are approved. ®»
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Sketching reveals a mistake

Using the previous sketches as a base, I combine the
elements into a single sketch, and then set to work
creating a clean piece of line-art to work from. It's now

that I run into my first mistake. At this stage I should have Starting on the colours

taken a step back and constructed the face properly. Had I decide on a simple desaturated background to begin with, choosing to focus
I done so, I would have seen what would later be revealed ~ on a lot of contrast and colour play on the character. During this point in the

as I began to add colour and light. This does happen from  process I spend time looking up some references. As well as taking some deep dives

time to time, and it comes down to the fact that you can on Google and Pinterest, I enjoy leafing through Jimmy Nelson’s Before They Are
get away with a lot more in a drawing without it becoming  Gone. This is a book about tribal societies around the world, and is filled with
problematic, than you can in a painting. beautiful photos on each of them.

Introducing light and shade

Once the colours are established I move on to the lighting and shadows, and
in the process run straight into my second mistake. I like to put down my shadows
using a Multiply layer: first laying them in very simply and directly, before going
over and softening up any edges that need it. I'll usually spend a good amount of
time in this stage to make sure I have something I like before moving on, and while
I don't rush it here, I should have spent a lot more time working out my details
beforehand. Yet [ had a somewhat painterly result in mind, and this was my second
mistake. I had spent time researching the subject matter, but none on working out
the precise execution, and this will come back and bite me in the proverbial ass.

W iiaEsieX July 2018

Fixing the background

When I have all the lighting information established
I pop a Normal layer on top of everything and begin to
paint for real. At this point, depending on how well I've
done in the other steps, I usually get to have a lot of fun
rendering out neat little details, pushing and pulling
volumes, and designing all the little elements that gives a
viewer a reason for a second look. It’s during this stage
that I decide the background is looking dull, so I try to
rectify things with larger brush strokes. [ want to leave it
abstract, yet use it to help move the eye. However, because
I've already established the light on the character, I can't
alter the main elements in the background.



In depth Striking figure

All:  100%

Streamlining my workflow
As I began to find something I can push to a finish, I decide to commit to what I've got so far. So I duplicate all the composite layers that
make up the character and combine them separately. This enables me to more easily work with the Smudge and Mixer Brush tools.

Letting the image rest in my mind
At this point I realise that I've stared at this painting for too long, so I leave it for half a day before coming back to it. And of course, by then
I've had just enough time to let my insecurities get to me, and so began to fiddle some more with the background. »»
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Tackling the values in the scene

It’s at this point that I look for values rather than colours, and began to play
with the idea of stormy clouds in the background and cold light from an overcast
sky contrasting with the tones of reflected light from the landscape. I work more on
the character, too - getting her to a place that's close to her final appearance. Once
there I send it in for ImagineFX's final approval before finishing.

Punching up the details by increasing the contrast

Acting on more feedback

After the second round of feedback I go to work
addressing the team’s notes. In general, there was a call for
more colour and a brighter background, perhaps
something that would read like a sandstorm. I like the
idea of that as a palette, although the sandstorm itself
might look odd with the character being so formally
dressed. I end up getting what I had wanted before,
however - a nice, rough, painterly background - and
thanks to the art direction this really helps the image.

The second round of feedback had also done away with her tribal scar patterns, and so I want to leverage the details of the figure in another
way, by really pushing the contrast within the figure. Using a Curves adjustment I achieve something I like. Then I begin to do a second round of

rendering on top, collapsing all contributing layers down into one for ease of painting.
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Solving lighting issues, and problems with anatomy
As I'm wrapping things up I decide that the contrast between the background and foreground light isn't working for me, so I use a Darken
layer to alter the colour of the front light, which sets up a clearer contrast. This is something I should have planned from the start, and could have
done a much better job in setting up so that the overall effect would have worked better, but sometimes you just have to improvise. I also have to
deal with my sloppy initial drawing when I finally realise that the face is reading too wide. I use the Lasso tool to make the necessary adjustments.

Summing up my process

I'm happy with how the piece has turned out, although the path I took in
getting here was less than optimal. Solid planning prevents poor performance and
in this case it’s proved to be true, if not disastrously so. Spend your time where it

Finishing touches matters: the initial stages is where you'll ultimately make or break your image.

One last round of rendering, when I push a few Check that the fundamentals are solid, that your choices aid the image, and always
details around and simplify some of the busier parts of have a plan that you can refer to. That way you won't freak out too much when you
the silhouette, and I'm ready to call it done. I add a final realise you've screwed something up, and you'll always find a way to finish the
Curve adjustment layer to gently move the colours into piece. I hope this workshop has been helpful, and I also hope the fine people at
the blues, to contrast a little more with the background. ImagineFX will have me back sometime in the future! g
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ZBrush & Photoshop 2 ‘

QUICKLY WORK %
UP A 3D CONCEPT

Adam Dewhirst conceives an idea in ZBrush and then turns it into a fully
realised concept using Photoshop and photobashing techniques

i Artist” When concepting through how to combine both tools | shape it and render some coloured
creatures in ZBrush, to turn a loose concept into a fully | and lit images, and then composite
. presenting a greyscale, | realised idea, playing to both | those together in Photoshop.
Adam unposed sculpt of your | programs’ strengths. | I'll then use a range of surface
Dewhirst b ) idea can make it hard A basic understanding of ZBrush is | samples to bring that design to life,
SOCAHORES for an audience to realise your vision. | necessary, but only the basics because | adding skin surface, lighting effects,
* Adam is the modelling Equally when using Photoshop, it we won't need to use any advanced | and a textured environment. It's a
and textureistperyison might take you some time to achieve | techniques or workarounds. great quick way to present a concept
for The Mill in New York. . . . , .
(AT - a three-dimensional feel to your Essentially, I'll be using ZBrush to for an idea, without having to take
experience in film, design. So in this workshop I'll walk | block out a design with ZSpheres, | it through a complete 3D pipeline.

commericals and TV. He
was the lead modeller on
Guardians of the Galaxy.
instagram:
@dewhirstadam

- Rough concept
M RESOUR(ES 3l Mostly I'm just using the Clay buildup brush to

"“-l-u-.....,“,,_-‘

roughly shape the concept. The aim is not to be bogged
down with making it look good - it isn't. I just want to
ZSpheres block-out brainstorm an idea. I want to make the ears look like
I like to use ZSpheres to rough out the entirety of my character as a first block.  leaves, and I'm trying out an idea where his skin would
It gives me a better sense of the whole shape, and forces me to focus on areas of the imitate bark, and possibly have mushrooms growing on
sculpt other than the head, which is the clear temptation. In this case, my idea is to it. My inspiration for this are the faerie-like creatures from
create a kind of magical forest hare. Guillermo del Toro’s films, such as Pan’s Labyrinth. »»
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New build using ZSpheres
I'm starting from ZSpheres again to block out the
Paintover stage in Photoshop main build. This time I'll load in the paintover as an
After about 30 minutes or so I take a screen grab of my loose idea and bringit ~ image plane and use it to line my concept up. It's worth
into Photoshop. Here I can eliminate the weakest areas, and sketch up areas that I taking your time to get the base shape right with the
want to change or develop further. I'm going to eliminate the mushroom idea, and ZSpheres, because it'll save you from having to
focus on the four leaf-like ears as the defining characteristic of this creature. retopologise or dynamesh the mesh multiple times later.

Create a basic sculpt of the creature

Using my paintover as a guide, I can quickly block in the larger forms of my creature. I'm primarily using Clay buildup, Move and Dam
standard brushes for this. I also use the Mask function by holding down Ctil to isolate specific areas such as the nails. To create the eyeball, I use
the Insert Sphere tool and then separate it to a separate sub-tool.
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In depth 3D concept

Polypainting the forest creature

To create a basic skin tone for my creature I set the material to SkinShade 4, and flood the colour with a bright orange. I then place
an inverse mask on the cavity to darken up the recesses, and use a combination of ZBrush'’s default Spotty and Veiny alpha maps to create
a distinctive mottled pattern to the skin using red, yellow and brown tones.

Lighting the scene and varying the backgroun
[ want to ensure I get the lighting direction correct when I comp this into my background, so I bring in a number of different background
options as image planes, to see what works. My lighting setup is basic: I have my main light and a rim. I'll create everything else in Photoshop. =+
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4. Pose the figure to convey an emotion
Once I'm happy with the lighting and general concept, I quickly alter the pose
to be less symmetrical. I do this using Masks and the Transpose tool, to mask out
the limbs, head and torso, then rotate it into a more interesting position. I'm trying
to create the impression that this creature is coming out of hiding, and is a little
timid or curious. The pose is a great way to convey this to the viewer.

(7. Assemble the renders in Photoshop

: To assemble all your passes, simply stack them as layers in one document in
Photoshop. I then going to convert all my lighting passes to Screen mode and adjust
the Opacity to decide how much directional light I want on my creature. This
creates a ‘cheated’ global illumination look. I also add in my shadow pass on a
Multiply layer and use the mask I've create on the group folder of all my passes. This
means I can work on my creature and background separately.

W lifiasimerX July 2018

ambient occlusion
\

reflective shader

Render the woodland beast

I'm rendering in Preview Quality mode, which is
the default setting. First I render out my basic shaded/lit
image, by pressing the BPR button and exporting the
document. Then using only the main light, I reposition
it to render out light information as separate passes from
the left, right, top and bottom. Finally, from the Render
menu and BPR RenderPass options, I export out the
shadow, ambient occlusion, depth, sub surface and
a mask as separate passes — all in PDF format.

Adding texture to skin surface

I've assembled a bunch of images to try on his skin
surface to add a little noise. The first one I want to apply
is an actual leaf texture, so he has the sense of being
crafted from nature. I'm also applying some elephant skin
along his arms, and some heavy leaf detail to the ears.



In depth 3D concept
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Altering the background to swt the character
I don't like my current background image. I want the environment to appear wilder and more magical. The colours are great though,
so I blend in other autumn woodland scenes to fill in the blank spaces between the trees, then add some foreground elements

Adding filter/vignettes

Gradients and vignettes can frame your work nicely,
I use these as Overlay layers to focus the lighting on the
character in the middle of the image. I'm going to use a
vignette with oranges and circles to give a subtle magical
tone to the background, and also a vertical gradient to
darken the edges of my images. This helps to place the
focus to the character in the middle

Final environment touches

In order to sit my character comfortably in the environment, I duplicate the
group, merge it and then blur the image. I then apply this as a layer mask and try
to match the focus of the background image. I'm also painting in straw and moss
at his feet to blend with the foreground image, and faking a little shadow
underneath him. Now my creature concept is ready for his close-up! @
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Core skills: Part 4

HOW TO MASTER

Workshops

PHOTOSHOP MASKS

Mark White takes a look at the function of masks, vector masks and
clipping masks, and shows you how to use all three effectively in your art

Mark White

LOCATION: UK

Mark is the techniques

editor for our siste

magazine Photoshop
Creative, where he

writes tutorials for

both Photoshop and
Photoshop Elements.
www.be.net/mrkjhnwht

Artis all about
expression, and
sometimes in digital
art illusion is just as

Hiding is as important as showing.
r Just as the Eraser is as trusty as the
Pencil when it comes to making
sketches, Photoshop offers its own
ways to hide parts of your work,
leaving only the polished finished

, important as display.

i product. The most effective and
accessible way is through a mask.

Let’s start at the very beginning.

Photoshop’s workflow is built upon
| layers for you to draw. But what you
| draw on a layer doesn'’t necessarily

| have to be what you see in the final
- image, thanks to masks. A mask

i defines how many pixels you actually
- see of that layer, while filtering out

. everything else. Regular layers masks

| consist of black and white pixels that
| either hide or show detail on your

| layer. A vector mask will create

| shapes to hide layers. And a clipping
. mask will help you to add pixels just
. to the layer below.

Masks are what makes digital art

in Photoshop. It provides you with a

non-destructive way to erase, and

really, what you don't draw is just as
: important as what you do.

Use any selection tool or

drawing tool to make a
mask. For example, you can
as we have,

use the Pen tool

Lassos which you can fill
either black or white, or

even brushes of
fade your layer i

any kind to
n or out.

D.-'

Adjustments  Libraries

Add an adjustment
¥ Y
EHole o s
GR=E R

Channels  Paths

Layers
£ wina = eTDOALR

~ | Opacity: 100%
wock: B o b I @

o GSEB—I Layer 5

o

Normal

Fllk: 100%  ~

Masks will automatically be locked to
their layers, as indicated by the padlock
icon in between the layer and mask in the
Layer palette. This means that if you
move the layer, the mask will follow.
Click the padlock icon to disable this.

Cmd/Ctrl+click the layer mask
preview to select all of the
pixels of that mask. Hit Cmd/
Ctrl+D to deselect all pixels.
Hit \ to show everything
you’ve masked out in red.

7 NMRJVUNGLRS

ot g~ T N

Create a mask of your artwork
A regular mask is just a monochrome extension to your layer. Here we've drawn the silhouette of a girl on the painted layer with the Pen
tool, and then hit the Mask button (that little square icon with the circle inside it).
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Save masks

on new layers

If you want to save a mask
for later, create a layer
and fill with your selected
pixels. Hide this layer; you
can still Cmd/Ctrl+click it
at any time and apply it

as a layer mask on one of
your layers.

We’ve applied two simple colour-
changing layers as a clipping mask to the
original painted layer, which has been
masked out. You can apply anything:

a new drawing, brushstrokes or more.\//r

Alter specific areas of your art with clipping masks

So you've drawn something on your first layer, and then used the Mask tool to only show some of it. By drawing something on another new

Core skills Photoshop

You can add as many
clipping masks to your
layers as you like,
including Adjustment
layers, which will add
tonal or colour changes
to specific parts of
your artwork.

To apply a clipping mask to a
layer, move the layer you’d like to
use as a clipping mask above the

layer you’d like to apply it to and
then Alt/Opt-click it to pin it
down to its corresponding layer.

layer and using a clipping mask, you can apply this layer “within the lines” of your masked drawing.

You don’t need to apply
the selecting youdoina
Vector mask. Just use the
Pen tool to create a shape,
or multiple shapes, and it

will magically appearon /

the Vector mask. ’

!

Work within the limitations of vector masks
A regular mask will enable you to use any selection tool or drawing tool to either show or hide pixels. In contrast, a vector mask will only
make it possible for you to use the Pen tool to show or hide parts of your masked layer. %+

Use the Paths tab to
perfect your Vector
mask and work on it
as you would with
any other path that
you create with

the Pen tool.

Just as with regular masks,
Vector masks are locked as
default. They use white on the
layer preview to show the
pixels that are visible, and they
can be hidden by Shift-clicking
them in the Layer palette.

Adjustments  Libraries

Add an adjustment
WY
EHale O
HE=EmE

Channels  Paths

Layers
P King

Hue

Filk; 100%  ~

Libraries

Adjustments
Addlnulll\llmm
D RV
Houe O B
HEEXE

o

‘D Layer § copy
=

L L
:. Layer 8 copy
‘. Layer B
oL 2 B

ADQmOE
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Create a group by selecting all the layers that You can use masks and vector
you want to combine in the layer palette and masks on groups. This won’t Channels  Paths
dragging them onto the folder icon. Alternately, interfere with the masks of
hit Cmd/Ctrl+G once you have them selected. individual layers within the B @ T O B
groups themselves, and you
can still Cmd/Ctrl+click ~ Opacity: 100%
masks to select the pixels.

~

Fill: 100%

If you want to move specific layers
within the groups, click V to bring up
the Move tool. Use the dropdown menu
in the top bar to choose between
selecting either the masks or the
groups when you click on them.

Grouping mask layers for more effective working
It's easy to group layers that have masks, and then apply masks to the groups themselves. This enables you to hide parts of your layers that
already have parts hidden. You may even want to group individual layers to keep masks within masks as editable.

= girlpsd @ 16.7% (Group 1, Layer Mask/B) *

The viewing window The Smooth option
enables you to see your simply smoothens the
masked space either edge of your mask.
against red, black or Feather will soften it
white, or even as further and Contrast
marching ants. This is will increase the tone
useful depending on within there. Shift Edge
what you’re working on, will physically move the
and can help you edge of your selection
visualise your changes. either in or out.

Output Settings Ciaar Selection
determine whether
the changes made to
your selection are
applied immediately, Remomber Satiings
or simply outputted
as a selection for
you to edit further,
should you wish to. )

J  Oltput Settings

f206: WIS OMSTAS S

Refine your art with the Select and Mask tool
Once you've made your masks, it's possible to refine that edge even further; that used to be called the Refine Edge tool. Well, now it's called
Select and Mask. Ctrl/right-click a mask preview window in the Layer palette to choose this option. g
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*Toni Infante
¢ brings a sense
| of grittiness to
. nextissue's
. _cover art!

S o e
b -‘.=¢f ’.)- }

magiiie

Manga art!

Collateral Damage Studios shows how it creates great manga.
Plus, check out Riot Games' Paul Kwon's home setup!

ISSUE 163 ON SALE IN THE UK Friday 15 June
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Artist Insig

15 SURE-FIRE WAYS
TO GET MOTIVATED

Are you stuck in an art slump? Then it’s a good thing Mel Milton’s on
hand to share his advice on staying motivated and being productive

Arthas been a huge i fearless early on because I felt as | motivation and drive continues to
gift for me and I'm | though I had nothingto lose. Itwasa | evolve. While some of these tips may
: grateful to my pastself | tough road filled with self-doubt. | seem basic, I still revisit them to
Mel Milton == for takingthe chance |  Ibelieve that a majority of my | understand why they work so well for
LOCATION: US L > | topursueit. Ididn'ttry | growth asan artist came tomenot | me when I'm stuck creatively.
T — to make a career in art until I turned just by practising and learning, but These tips, in my mind, are the
animator for video 30, and I didn't get my foot in the | through analysing my mindset | foundation for getting clear about

ga"‘es Spe":_s ha'tf il door until I was 33. i during that process: looking at why | how to motivate yourself to create for
Ime as an agjunc i

e e Becal.lse .of what I considered were being an artist.was. o) appeal.ing; longer periods and be excited to do
drawing, and the other my limitations, I didn't take this i where my motivation and drive ' so. I hope they're helpful to you as
SEEIEEEEEEEAS  opportunity for granted. [ was pretty | were coming from; and how that ' much as they were for me.

https://ifxm.ag/melm

TSET GOALS AND CHALLENGES

You need two things to get where you want to go: a starting point and a
destination. Leave out either one and you’ll end up feeling frustrated and
believing that your efforts are pointless. Goals are the best way to start setting
a destination for improvement. For many years | just wanted to get better. The
problem was that | didn’t take the time to define what it really meant to “get
better” - it’s such a vague concept.

Having small-, medium- and long-term art goals helps solidify a sense of
purpose to your work. One approach that helped me was to limit most goals
to about 30 days each. Thirty days of doing a task usually makes it easier to
turn it into a habit that stays with you while you tackle other subjects.

Make your first few challenges more about having fun. Connect them to
something you geek over (I spent a month drawing different takes on Wonder
Woman). Eventually, the 30-day habit will feel natural. You can then move on
to challenges that are geared towards areas of weakness. For me, that’s
handling colours. Carry out small studies and learn one new facet of that
subject each day. After 30 days you’'ll have a strong understanding in that area.




2 WHY YOU NEED A “WHY”
When | was younger, | liked being told
| was good at art because | was a
failure in pretty much every other
aspect of my life. My “why” | drew
was easy to see and the results were
enough to make me happy with
where | was with my art.

When | met my wife, my “why”
changed to “l want to take care of my
wife and family”. Up until this point
| had never tried to become a pro

Artist insight Get motivated

- artist. This new “why” took over and

| | set off to do something | didn’t think
' | could do but now, in my mind, |

. actually had to. It helped me identify
| previously unseen opportunities. It

. also made me focus less on the

. obstacles and more on the solutions.

The easiest thing to say is, “l want to

. be a good artist.” However, having a
| meaningful reason for why you want
' to be a good artist helps you reach

' that goal much more easily.

3 SET ASIDE A FEW MINUTES FOR MINDLESS DOODLING
Practising specific subjects or techniques can be draining after a while. So when I’'m stuck
and not motivated, I'll spend 15 minutes just doodling. This is a chance to experiment with
shapes, sizes, colours and so on that | don’t normally tackle. There’s no pressure to learn
anything from them and | usually go over the results on a day that I'm in the mood to draw,
to see if | can take something from them. | doodle both traditionally and digitally.

Some days | challenge myself to make mistakes on purpose, do as many things that | think
don’t have appeal, and then laugh about them. Those kind of days give me the ability to not
take things so seriously. They’re reminders that it’s okay to be messy, make mistakes and go
a little out there just for kicks and grins. You never know what you’re gonna bring back.

4 HAVE A DAY OF

BRAINSTORMING

Come up with a list of things that
pigue your interest. This can be
everything from films, video
games, books, animals and foods
to favourite holiday locations,

I sports, and inspiring people and

i places. With films, books and

i video games alone, there’s a

. plethora of genres and characters
. to pull from. | usually do this at

| the beginning of the week to be

| consistent throughout that week.

' Making brainstorming a long-
- term habit will get your mind

- looking into areas that you

- wouldn’t have normally thought

- of, as well as give you a library of
- topics to work from when you’re
' lacking motivation. »»
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5 EXPLORE A TOPIC
THAT EXCITES YOU
| usually paint female
portraits (see tip 6), and
have been working on just
that subject for about 18
years now. It had nothing
to do with work or making
money. It became more of
a long-term challenge. |
always felt | wasn’t clever
enough to understand
anatomy. So | hid that
weakness by drawing
monsters, where | could
make up my own anatomy.
| settled on portraits
because | thought if | could
capture the subtleties of
the female face and form,
| would have more control

1 over lines and shapes. All

6 WORK FROM BIG TO SMALL

my art heroes could draw
women well and make
them strong in nature, yet
retain the feminine appeal.
What | learned (and still
learn) from just the one
subject is that | may have a
better understanding after
all this time, but | know Ill
never learn everything on
that subject. It’s helped me
to see things | wouldn’t
have to known to look for
when | first started. | now
take those observation
skills into other areas of
study, which has helped
me to be excited to learn
things | normally wouldn’t
have attempted to tackle.

When I’'m motivated, it’s hard not to just jump right into the polishing stage.
Yet by holding off as long as | can, I'll get more done in less time. Observe...

Going large with strokes Refine facial features

| usually grab my local colours and | begin blending colours by softening
apply generous-sized strokes that indicate edges. | also add some slightly smaller
where the main features are, such as the shapes and refine others to further refine

direction of the lighting, large shadow

features like the eyes and nose. This is the

shapes and warm/cool areas. It was tricky stage where you can get caught up in doing
for me to work this way early on because | the details, but | find it easier to make major
had a hard time looking past all the ugliness.  changes if necessary during this stage.
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Dive into the details...now!

Everything | add now is to encourage
the viewer’s eye to travel around the image.
| don’t go too crazy and make sure
everything supports those elements that
are important to the picture. If you have a
solid image going into this stage, the details
become the icing on the cake.




Artist insight Get motivated

P

7 DECONSTRUCT PAINTINGS OR REFERENCE WORK

Copying other people’s work or references was taboo early on in my journey to
become an artist, so | tried to steer clear of it. But when | started my first studio

job I noticed that there was a lot of reference usage. My co-workers would

gather inspiration pieces, deconstruct them and then come up with something

new. | felt betrayed because | thought everything was done without reference!
Being able to access so many great artist these days can be overwhelming

and make you feel as though you’ll never make your mark on the art world. Yet

if done properly, using reference and emulating your favourite artist can give

you some great insight into the creative process. Especially when you set aside

the original artwork and apply the techniques you’ve learned in your own way.
You'll achieve the right results with the knowledge that it’s all your own work.

8 MEET WITH LIKE-
MINDED ARTISTS
There were days when |
wondered if anyone went
through the struggles
| experienced. It was tough
because | didn’t have a lot
of peers who were into art.
| always felt that it had to
be easier for others.

Once | decided to

out to as many creatives as
| could, meeting them for
lunch to pick their brains.

| wasn’t after technique
advice - instead, | wanted

. to know how they handled
- mental challenges and to

- see what they were like as

' people, rather than artists.

I’m lucky to have such a

' huge pool of creatives in

- my life. | usually do a

. weekly draw lunch at the
- local mall’s food court. It’s
' nice to be able to see a

| variety of challenges that
become an artist, | reached |
' varying fields and at

- different stages of careers.
' It’s a great way to be

- educated, connect, to

' nurture and be nurtured.

life can throw at an artist in

@

9 REMEMBER TO DREAM BIG!

I've been a dreamer my whole life. | believe it’s the reason
why I've stuck with art for as long as | have. | would
imagine all kinds of grand experiences that being an
artist would enable me to have. Yet once | made art my
career, | noticed that | didn’t dream as | once did. | lost
some of the sparkle that | had as a beginner artist. It
became harder to bring the dreamer out. | didn’t want
him to get hurt. It’s sometimes easier to just go through
the motions and play it safe.

When my daughter was born it challenged this
approach to life. | realised that it’s the dreamer who
keeps me at it - even when | don’t like what I’'m
producing. It’s the dreamer who gives me the ability to
move forward with my art in a positive way. It’s the
dreamer’s imagination that makes it possible to glimpse
at the artist you want to become and feel the joy of it
now. Take a chance on nurturing that dreamer. #»

66 I realised that it's the
dreamer who keeps me at it
— even when I don't like
what I'm producing 99
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10 KEEP A JOURNAL AND LEARN
TO REALLY LISTEN TO YOURSELF
A journal is a great way to see what’s on your mind before you
draw. For example: “I didn’t sleep well last night and had a lot
of things that | needed to get done. Man, I'm irritated today!”

| noticed | would take these types of aggressive moods into
my drawing time unintentionally. By writing them down before
| drew, | learned not be as harsh a critic after | had finished a
drawing. It was understandable that when | was irritated, |
didn’t produce the same quality compared to when I was in a
good mood. | could show myself some compassion, much like
| would with a friend going through a tough time. After a while
| learned to look for things that could improve my odds of
having a better learning experience - to get into the zone.

Another benefit comes if you keep a journal for a long time.
You’re able to go back and see how different your thought
process was and find out what was successful and what
negative patterns were showing up that you hadn’t noticed
before. Writing down my thoughts before drawing warmed up
my hand. But it also helped me make more mindful decisions
and gave me a boost in my self-confidence.

11 SET A TIME LIMIT
When | chose to stay at home and raise my
daughter, | limited my art time so | could focus
on being a dad. | always felt guilty when | did
some art. Quick bursts while she was eating
breakfast or napping became the norm. A
benefit from doing this was my inner critic
went from saying, “Your art will never be good
enough” to “Come on! Fifteen minutes? You
can do more than that! I've got exciting ideas
you can try if you go just a little longer!”

My keenness to fit in my limited drawing
time kept growing and became quite
cherished. Stopping short also helped me to
carry that excitement into subsequent
sessions. | noticed that | didn’t suffer art
burnout as often and that my mind worked on
what | could do the next day more easily.
Nowadays, | have a bit more time to dedicate
to my art, but most of the time | limit it to
short sessions and find myself more inclined
to be excited every time | pick up my pencil.
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12 GET TO KNOW YOUR FEELINGS
Most of my tips revolve around the mental process. Emotions dictate
how we make decisions. Not only as artists, but as human beings. Look
at how many artist are insecure with their art! | know I’m one of them.
| thought it would go away once | turned professional... nope! Learning
how to express emotions through shapes, colours, composition and so
on has helped me see both sides: producing as well as consuming art.
When you’re working on the basics, take some time to understand
why you feel a certain way. When you’re working for someone, they’re
the ones who dictate what they want the end product to represent. It
can be overwhelming to create this way because we can’t really feel
what the other person is thinking, and we tend to make assumptions
based on what they say. So when we build a large library of techniques
for expressing ourselves in our minds, we have a better chance at hitting
the target for someone else’s vision.



Artist insight Get motivated

12 DON’T BE AFRAID TO
TACKLE THE BASICS (AGAIN)
In my rush to become better at art, | skipped
the basics. My mind would say, “Yeah yeah,
| know that.” Well, | learned that you don’t
really know something until you can apply it
properly - and more than once. The more |
learn, the more | realise | don’t know anything.
This is a great mindset to have as a creative.
Early on, everyone wants to be the master
of their craft. It’'s mainly where my drive was
coming from. The focus becomes this
destination we want to arrive at as an artist.
I’'ve come to realise the magic doesn’t come
from the achievement, but from all the things
it took to get to that place. When you retain
the student mindset and stay eager to learn,
you can revisit the basics with a degree of
excitement. From there, you can flourish in so
many different ways and gain the confidence
to bend the basics to your will.

& You don’t know something
until you can apply it properly
— and more than once 99

14 BE OKAY WITH FAILING AND BEING
FRUSTRATED AT YOUR PROGRESS

Bad drawing days are bound to happen. As long as I've been at
it, I've learned that my biggest growth came from those bad
days, especially when | looked at them properly. Being an artist,
you can be your worst critic, but that’s not really the case. We
just make it sound that way. When we have those bad days, we
tell ourselves how terrible things are, and that we’ll never
amount to anything.

What'’s really being said is that you’re not where you want to
be. That voice wants you to become the artist you want to be. If
your goal is to become better at what you do, then
dissatisfaction is a ruler on which to measure your progress.
Take time to look over how the journey is going for you at that
moment of frustration. | think all my work isn’t where it could be
- more so than when [ first set out to be an artist. I'm grateful for
this feeling. | get excited through my failures because | know
each one is a lesson that’s needed for me to grow and improve.

15 HAVE A HOBBYIST MINDSET opportunity. | was doing enough to
| know when | decided to make art | get my work done, but was missing
my profession, | got serious about i the love that pushed me to improve.
it... a little too serious, to tell youthe  Adopting a hobbyist mindset
truth. | loved toys, Saturday morning : helped me cherish the time | get to

cartoons, video games and comics | “art it up”. Even when | actually take
as a kid. When | wasn’t enjoying { on clients, | try to come from this
those things, | drew. By starting late | place. I've conditioned myself to get
with my career, | spent the early | excited at the thought of art. This
years excited to have finally arrived. | has made me more productive and

Soon, however, | started seeing it | excited to learn new things, which
as just a job. | never imagined I'd i could be beneficial to my creative
think of it that way. Especially i workflow. It’s the foundation of why
because I'd never thought I'd get the ' | “keep on keepin’ on!” g
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ZBrush & Photoshop

MODEL A SCENE &
FOR A PAINT-OVER

In this two-part workshop Ara Kermanikian reveals how he uses ZBrush
to model a sci-fi composition, creating a strong basis for a paint-over

Kermanikian
LOCATION: US

Arais a freelance
concept designer who
also teaches viscom
and character design

at the Art Center College
of Design and advanced
ZBrush, animation

and storytelling at the
Otis College of Art

and Design.
www.kermaco.com

In part one of this
workshop, I'll use
ZBrush to model the
main forms of a scene,
set dress it, add
lighting, decide on a strong
composition, and then render it with
a toon shader. In part two a snapshot
of the 3D scene will be used by Scott
Zenteno for a 2D paint-over.

Many artists and students
portfolios I'm asked to review are
often challenged by the same basic
fundamentals. The primary
challenge is creating a compelling

composition. The artist may have
good painting skills, but if the subject
is framed in an unflattering way at a
boring angle of view, then it will fail
to tell a story or communicate the
artist’s intent.

The second biggest challenge is
ensuring correct perspective.
Unintended errors in perspective and
foreshortening can immediately
categorise the work as unprofessional
and throw the viewer off.

The third challenge is incorrect
lighting, where inconsistent values in
the image create an uncanny look

because light and shadows aren't
painted accurately. Some of these
works can be rescued by an
experienced artist’s corrective paint-
over. However, most are
unfortunately discarded.

Creating a simple model of your
composition in ZBrush overcomes
these issues because you can fame
“the one” compelling composition,
or many camera vantage points that
tell the story. Correct perspective is a
given, and just as you'e able to iterate
figuring out the right composition,
you can iterate lighting and shadows.

Last mech standing
The first step of my workflow, if 'm not working on an assignment or script, is to put together a story. “In a futuristic city setting, the

. RESOURCES

See page 8 now!

protagonist — a pilot in a mech - has just finished protecting everyone from a gang of specialised gunslinger mechs that have come to wreak
havoc.” Some quick value comp sketches from Scott Zenteno get the ball rolling. #»
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Dynamic

Go back and
forth in time
Once you adjust your
viewport to determine a
strong composition, it’s a
good idea to save it so
you can come back to it
if you move objects. In
fact, you can save several
vantage points. To do
this, click Movie>
TimeLine to show the
timeline above the
viewport. Once you have
the desired composition
click the timeline to add
a dot, which will indicate
a saved view. You can
then click below your dot
to snap the vantage
point to that view.

ZBRUSH

CUSTOM BRUSHES:
KEMRMACO_MECHIMM

This Insert Mesh Brush
can be used to quickly
insert one of 20 mechs.

BLDGS_O1_IMM_
KERMACO

Channels

Establish environment perspective

ZBrush has settings for a variety of purposes, be it
sculpting a bust, a character or an environment. Since
we're composing an environment we have to change some
Choose from 20 buildings settings. To establish perspective for an environment,
I (IR e [ W) make sure that Auto Adjust Distance and Align to Object
this Insert Mesh Brush. .

are turned off in the Draw Menu. Turn Local off, too.

# lifiasimerX July 2018

Lay down perspective guides

Ensure Floor is turned on, and in the Draw menu,
set both Grid size and Tiles to the maximum 100, which
extends the floor to the horizon line and shows the most
perspective lines. For the camera angle chose a setting
between 60 and 22, which is inversely proportional to the
focal lengths of 25mm and 75mm of a DSLR camera.

Mech ideation setup

To 3D sketch out some mechs, click PolyMesh3D,
and in the Tool>Initialize menu select QCube with the
dimensions XRes, YRes, ZRes of 1. Turn on PolyF
(PolyFrame) to see each face of the cube in a different
colour, to indicate that it belongs to a different Polygroup.
In the Tool Subtool menu duplicate this cube 20 times,
which will be our starting points.



In depth Model a scene

Modelling the mechs

Select the ZModeler Brush to block out a simplified Create symmetry with Mirroring
shape of a mech. Hit Space while you're on polygon face To create a symmetrical mech, press X to toggle symmetry in the x-axis. You
and select QMesh, which is the default. Use QMesh to can also click Transform>Activate Symmetry to turn it on (note that you can choose
pull out and push in polygons from the cube to create a X, Y and Z individually, in combination or together). To find out the direction you
simple blocky view of a mech. QMesh snaps shapes you need symmetry in, click Floor in the right-hand menu to bring up the floor grid. The
pull out to adjacent shapes, adding to the volume. red line on the floor grid indicates the X direction, green is Y and blue is Z.

Insert

Inserting EdgelLoops

EdgeLoops help break up a shape such as adding Refining the form
edges to pull out a knee on a leg. While on an edge the Select the Move Brush to push and pull the form from the block-out shape to
ZModeler default action is Insert, which inserts an add gesture and design to the form. Note that the Draw Size of your brush will
EdgeLoop while your cursor is on an edge. Once you click  dictate the amount of points that youre manipulating, so adjust it accordingly. The
an edge, hold down the mouse button to position the displayed circle indicates the size: a bigger circle will make big sweeping changes,
EdgeLoop in the intended location. while a smaller one will make minor ones. ®»
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Make use of Dynamic Subdivision

Dynamic Subdivision previews ZBrush models
as if they're subdivided with the Smooth setting on.
However, you can still manipulate the low poly model

Create 20 mech iterations and see the results in real time. To activate it, press

Spend 10 to 15 minutes growing each of the 20 cubes into a mech design. Tool>Geometry>Dynamic Subdiv>Dynamic. You can
Click Deformation>Unify on each mech after you've finished it to change them also choose a setting in between hard edge and smooth
into a uniform size. The mechs will overlap, and you can use the Xpose button to by moving the QGrid and Coverage sliders. Once you're
expand them out into an array to select which ones will make it into the scene. happy with the results, click Apply.

Quickly create
building floors

ArrayMesh can be used
to add floors to the
buildings. Model a floor
layout and scale it so it’s
nearly flat, then Click
Tool>ArrayMesh>Array
Mesh. Choose the
number of floors and use
the Repeat slider to set
the number of floors.
Then, making sure that
the Offset button is
clicked, use the Y
Amount Slider to move

Finalise the hero mech’s secondary form
up the floors. Click Use the ZModeler Brush again to develop one of the mechs as the hero character of the composition. QMesh,

Tool>ArrayMesh> Make

Insert, Polygroup and Crease are ZModeler actions that can help divide and add detail to your model. You can also split
Mesh to create the floors.

off parts of the model such as the legs or arms by selecting the parts and clicking Tool>Subtool>Split>SplitHidden.
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In depth Model a scene

Run BPR

render passes
After you BPR render
your scene, ZBrush also
generates render passes
that you can use as
layers to composite in
Photoshop. Click
Render>BPR Render
Passes and you will
notice thumbnails for
your shaded object,
Depth, Shadow, Ambient
Occulsion (AmbOc) and
an outline Mask. Clicking
the individual thumbnails
enables you to save them
out as PSD files, which
you can load as layers
into Photoshop.

ik . F.i |,-,,. ! .

Construct 20 buildings Compose the scene with your assets

Now we follow the same process as the mechs, Click Individually select the mech or building in the
PolyMesh3D to start a new Tool. Create 20 buildings to subtool list and click Tool>Subtool>Copy and then Paste
add to your composition and remember to click to copy them into the tool with your floor. Click Move,
Tool>Deformation>Unify to ensure they have uniform Scale and Rotate and use the Gizmo to arrange your
scale. You now have two tools containing 20 mechs and models on the ground plane. Once you have everything
buildings, respectively. Select Plane3D and click Make arranged, navigate around your scene to find a good
PolyMesh3D scale - this is now your ground plane. composition and save your scene using File>SaveAs.

E L — s
Frsrss i

Render the composition, ready for the paint-over
Select the FlatColor Material from the materials list. Click BPR to render your scene, then select Render>BPR Filters and click the circle into

the open position for the F1 filter to activate it. Select the Colorize filter and move the Cavity and Cavity sliders to 1, Cavity Exp to 1 and

CavitySense to 11 to achieve the desired outlines. Save your document as a PSD by clicking Document>Export. Next month, paint-over time! g
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Oculus Medium

CHARACTER
CREATION IN VR

Glen Southern shows how VR sculpting has evolved into a viable tool
for taking a 2D concept and bringing it to life in three dimensions

Glen Southern
LOCATION: England

Glen runs SouthernGFX,
a small Cheshire-based
studio specialising in
character and creature
design and look
development, with
clients including Sky,
Nike, LEGO, Sainsburys,
Disney and Wacom.
www.southerngfx.co.uk

If you follow trends it's
® hard to miss that VR is
going through another
revival. It's happened

: before, but this time
it's slightly different because we have
more access to powerful computers
and graphics cards at home and in
our studios.

Companies like Facebook (Oculus)
and HTC (Vive) have made VR
hardware affordable - presuming you
already own a high-end gaming PC.

It didn't take long for creatives to start

asking what's in it for them, and the

call was answered with programs like

Google Tilt Brush, Oculus Quill,

Masterpiece VR, and the one we'll

be using today: Oculus Medium.
This article will show how to work

up a 3D character concept from an

existing character sketch. You can,

of course, work without the sketches

and just free-form sculpt your ideas.
Oculus Medium places you into

an environment where you can use

the touch controllers to spray clay
into the air in front of you and then
manipulate it into the shapes you
need. There’s a layering system so
we can break the character down into
poseable sections, and you can even
take it to a painted, finished concept.

The tool palette has a range of
familiar tools like Move, Inflate,
Smooth, Paint, Smudge, Cut and the
basic Clay Adding tool. You can also
make a shape, turn that into a stamp
and then use that as your tool.

~: RESOURCES

Bring the references into Medium

Save the reference images to your Documents Folder
(Look for the _import folder). Import the images from the
Reference panel to Medium. It’s the third button along
when you pull down on the thumb stick on the Support
Hand. Select the images you need, then in the scene click
each one and move it into place. Use the Check button
and attach it to your hand. #»

See page 8 now!

Using reference sketches

I always try to use good reference in my work. For this workshop I'm using a
character sketch of a little creature I've called the Triplop. I sketch the initial design
on my iPad, then produce a few different versions to see what works well as a
design. I ink it, colour it and then save out a few PNG versions.
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Control Pane|

‘.. SCULPT FiLg MAHAGEMENT

{

Silel .
EdlCK Savea

Working with the Mirror feature turned on

To work symmetrically, go into the Control Panel (Yellow Button, Support hand) and choose Mirror. Every action you perform now will
be mirrored across the work centre, including adding clay, painting, moving clay around and any deleting that needs to happen. Later on we'll
turn Mirror off and place my Triplop into a range of more dynamic poses using the Move tool.

Begin defining the body shape, starting with the torso
The character will be built on a few different layers, enabling you to pose it later. The default tool in Medium is the Clay tool and you add
clay by pressing the trigger on the Tool hand (your dominant hand). Create a belly and chest area going up to the shoulders. Add in a little tail.
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Introducing legs

Make a new layer that we can use for the legs. The
layer system enables you to adjust parts separately, flip
models, and increase and decrease the details level. Using
the basic Clay tool, lay down clay for the thigh, calf and a
basic foot. Hold the trigger on the support hand to access
the Smooth tool and level out the surface as needed.

In depth VR character creation

Add arms and hands

Add a new layer for the arms and add clay down from the shoulder to form
the biceps, the elbow and hand. Then create each finger, joint by joint. Using the
Smooth tool to get the volumes correct and then switch to the Move tool to tweak
the form (push forward on the support hand to access the Tool palette).

Laying the foundation of the head component
Add a new layer and call it ‘Head". Use the Clay tool to lay down the ball of the head. Add volume for the cheeks, the frill at the back, the
beak. Double-tap the gear icon on your Tool Hand and the clay turns red. Make two eye sockets. >
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Refine the shape of the creature’s head
The most important part of the character is the head and facial characteristics, so I spend the most time on this section. Using the Smooth,
Clay and Move tools I make sure that the head reads from all angles and that the mouth and eyes look appealing and friendly. Don't worry about

the eye shape until we add the eyes, because it's always easier once a sphere is in the socket.

Change the eye material

Create a layer for the eyes and use the gear settings
icon to change the material. Try metal if that suits you,
but the easiest way is to simply increase the specularity
of the material to give a glossy effect. Then reduce the
occlusion to reduce shadows. Turn on Mirroring and use
the Clay tool to add simple spheres for eyes.

magieX July 2018

Give the creature bright blue eyes

Now change to the Paint tool and paint with blue and black to create the
pupil and iris. You can change your Clay settings to ‘single’ rather than continuous;
this enables you to stamp down a single sphere rather than spraying constantly. The
size of the sphere depends on the size of the brush that you start with.




Create teeth and horns

Add a new layer for the teeth and horns. To make
the teeth, use a basic Cube tool (click the gear icon on the
Tool hand). Draw it onto the character, ensuring it
intersects with the upper jaw. Use the Smooth tool to
improve the shape and the Move tool if necessary. The
horn can be made by spraying the Sphere tool in an arc.

Detailing the surface

To add smaller details make the brush very small,
then hold your hand quite far back and ‘pepper’ the
surface to generate a mottled effect. Add lighter and
darker areas to give good contrast to the skin surface.
Check there are no flat-looking areas; if you find some,
add in some small details like wrinkles or light patches.

In depth VR character creation

Painting the base coat

To lay down the base coat, change to the Painting tool and pick a relevant
colour. Apply that to all skin areas. Make the colour a little darker and then paint the
recessed areas. Choose a few different colours to match your design and gradually
build up the overall look that you're after.

Final passes and poses

To pose the model, duplicate each layer (not the head) and delete either one
side or the other. That way you'll end up with two legs, two arms and so on. Now by
selecting each individual part you can move the parts around to achieve dynamic
poses. If you need to go more extreme, use the Move tool set to a large brush. g
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92 iPad 9.7
The ubiquitous gadget of the 2010s rolls on |
into its eighth year, even more laptop-like |

and art-friendly than ever before. | COLOUR
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95 Sci-Fi Corridor ' 97 The Art of Paul Gerrard:

Concept design artist Vaughan Ling creates | Monochromatic Beginnings

a cool-looking passageway that you can | The legendary concept designer revisits the

render from any angle you wish. | start of his career with this collection of

BOOKS - - black and white artworks.

96 The Art and - 97 Ann Blockley’s

Making of Rampage i Watercolour Workshop

The production team behind Rampage i Discover new ways to paint with
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monsters into heartfelt creatures. I innovative approaches to the medium.
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iPad 9.7

TABLET TAKING The ubiquitous gédget of the 2010s rolls on into its
eighth year, even more laptop-like and art-friendly than ever before

Price From £319 Company Apple Web www.apple.com

There are plenty of digital art
apps on the App Store that
are capable of helping with

on-the-go drawing, including

Procreate and ArtRage. Here, we
used Photoshop Sketch.

he late Steve Jobs only had

one word to describe

styluses in relation to his

pioneering products:
“Yuck”. His idea was that no one
would ever need them so long as
they had fingers to use, and it was a
mantra that persevered at the
company he founded, for a little
while after he passed away.

When Apple finally did release an
accompanying Pencil to use with its
iPad, the world referred back to Jobs’s
now infamous put-down of the pen.

< .

But perhaps not even Jobs could have
foreseen how touch screens would
evolve into the new decade.

The new iPad for 2018 promises to
deliver the power of Apple’s most
ambitious products, with the price of
some of its most popular. It’s good
news for digital artists. For a start, the
Apple Pencil is fully compatible, so you
needn’t fork out for the top iPad
model. The new chip makes it quicker
and split-screening makes it easier for
multi-tasking, but the first impressions
of the new iPad aren’t exactly

The Apple Pencil is
superb for digital
sketching, and the iPad
makes it possible to rest
your hand on the
screen without it
coming out on your
canvas, as it were, as
only the Pencil’s strokes
will be recognised

# lifiasimerX July 2018

breathtaking: same resolution, same
old design, same rigid iOS that you
can’t completely customise to your
tastes. The Pencil certainly makes it a
bit more interesting, but then you have
to pay separately for that (£89).

Despite these irks, which admittedly
come from most customers on new
Apple releases, this is the most solid
effort from the company yet when it
comes to its tablet. It’s got a decent
10-hour battery life and the camera,
although barely improved from
previous models, still boasts eight
megapixels. That’s more than enough
for an artist to take reference
photographs with.



The design follows the classic
iPads of the past. It’s thicker than
the old iPad Air used to be, but it
comes with a whole lot more
power to boot, too.

The new iPad’s screen is bright
and colourful enough for you to
get exactly the right shade for
your art. Note that the speakers
are located at the bottom of the
device again, and though the
sound isn’t particularly bad, it’s
not as good as the iPad Pro.

&6 The power is phenomenal compared
to previous iPad models. It handles

sketching with no trouble whatsoever %9

The power is phenomenal in
comparison to previous iPad models. It
handles sketching, for example, with
absolutely no trouble whatsoever, and
switching between apps is faultless.

The Apple Pencil is simply light
years ahead of most styluses in the
market too, with details easy to create
with the tip, and shading possible by
drawing at an angle. The pressure
sensitivity is superb, too; this is good
enough to rival many graphics tablets.
This is the elite combination for digital
drawing on the go, and at a fairly

reasonable price, it’s a serious option
for the beginner or a professional.

This is still the best tablet on the
market. With the rate that touch
screens are evolving, it’s becoming
ever more essential for digital artists to
own an iPad to use on the go, and all
things considered, this latest iPad is
the best fit for the job. It’s quicker and
stronger and will last far longer than
any iPad before; the Pencil too is
superb in quality and well worth the
money. If Steve Jobs were here today,
even he would be impressed. @

Art tools Hardware

Features

W 32 or 128GB versions
W A10 Fusion chip with
64-bit architecture

W 2,048x1,536
resolution at 264 ppi
M Eight-megapixel
camera with Live
Photos and Panorama
(up to 43 megapixels)
W 1.2-megapixel
photos front camera
W 1,080p HD video
recording

Wios 1

System
Requirements
PC: Windows 7 or later
Mac: OS X 10.10.5

or later

(for syncing iTunes)

THREE IPAD
ALTERNATIVES

There's a tablet out there for
artists on all budgets. ..

Surface Pro

Web www.microsoft.com
Price £799

—

Microsoft's flagship tablet, the
Surface Pro, looks and feels

very similar to its laptops. It's
considerably more expensive
than many iPads, and the Surface
Pen isn't nearly as good for digital
art as the Apple Pencil.

Tab 4

Web www.lenovo.com
Price £170

Lenovo's Tab 4 is an Android-
running, robust tablet with a
battery life twice as long as the
iPad and expansion options via an
SD card. It's nowhere near as slick
or quick as the iPad, but it's a good
option for artists on a tight budget.

Galaxy Tab S2

Web www.samsung.com
Price £329

Perhaps the most similar prospect
on the market to the iPad, the
Galaxy Tab has a similar price,
build and screen quality. The
processor isn't as powerful
though, and the iPad is superior
for using for creating artworks.
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Vaughan Ling’s 3D corridor makes an ideal
backdrop for your sci-fi figures - and you
can make your own version in Blender.

[nspiration Training

Sci-Fi1 Corridor

PIPE DREAM Concept design artist Vaughan Ling creates a cool-
looking passageway that you can render from any angle you wish

Publisher Vaughan Ling Price £23 Format Streaming video Web www.gumroad.com/vling

hen it comes to taking your

first steps in 3D software,

Blender is a pretty good

choice. Created by the
open-source community, Blender
is free to download, yet is capable
of decent results. It’s not as
complicated to pick up as programs
like Maya, but you can still expect
somewhat of a learning curve - which
is where good training can really
make a difference.

Vaughan Ling’s latest training video
isn’t necessarily for beginners, but it’s
one of the most accessible projects
you're likely to find. Vaughan gives
precise narration about what he’s
doing and which controls he’s using at
every stage - no mean feat given the
length of the video - and makes you
feel like recreating this moody
backdrop is well within your grasp.

The video’s packed with useful skills
and techniques. Just one example is
when Vaughan shows how you can
select objects through their vertices,
their edges or their polygons,

Topics covered
M Building the base
W Panel details

W Materials

W Text and decals

M Environment styles
H Animating the lights
M Animating the
camera

M Rendering the
animation

Length

254 minutes

encouraging you to choose the most

. efficient and accurate method for any

given situation.

He also teaches some good design
skills, taking inspiration from
unexpected sources like espresso
machines and showing how variations
in scale and rhythm can make a

potentially dull, industrial environment
like a corridor look interesting.

Towards the end, you'll also get
some great lessons in setting up the
final render, as Vaughan shows how
straightforward changes in lighting
and render settings enable you to give
the same basic scene a few distinct
looks, from futuristically clean to
ominously moody.

The result is an excellent Blender

. primer, although it’s only available as

a streaming video, not as a download.
This means the video quality can be
variable if the Gumroad server hosting
the video is having a bad day, and

you don’t get a copy of the video to
keep - which is a shame given its
repeat value. @

You’re shown every
stage of the project,
with clear instructions
showing how to set up
essential elements such
as surface materials.

There’s a brief
run-through on simple
animation techniques,
so you can have a
camera track all the
way down the corridor.

ARTIST PROFILE

VAUGHAN
LING

——— e [ e —
Based in California, Vaughan
specialises in designs for vehicles,
props, weapons and
environments to appear in films
and games. Clients have included
Warner Animation Group,
Disney, Marvel, Psyops,
Insomniac Games, Mattel, Honda
and Trek Bicycles, and projects
have included TRON: Uprising,
Sunset Overdrive and The LEGO
Ninjago Movie, as well as
community collaborations
including Ghost In The Shell

(Project 2501).
Vaughan's also
taught at Concept
Design Academy
in Pasadena.

www.heavypoly.com
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Mutant beasts have it
out on the Chicago
streets, in this dynamic
piece of concept art.

Concept art of
Dwayne Johnson
and Naomie Harris
escaping the
carnage on the
city streets.

The Art and Making of Rampage

CODE MONKEY The production team behind Rampage reveal how they turned
furious mutant monsters into heartfelt creatures in this making-of book

Author Ellen Wolff Publisher Insight Editions Price £32 Web www.insighteditions.com Available Now

he nostalgia for arcade
games is still going strong.
Rampage brings the 1986
Bally Midway arcade game
of the same name bang up to date
with groundbreaking visual effects.

It’s not just the look of Rampage
that gets spruced up in this latest
cinematic outing for Dwayne ‘The
Rock’ Johnson. As we learn in the
foreword from the man himself, an
added element of friendship between
man and creature runs through the
whole film to give the action
sequences extra emotional heft.

In fact, Dwayne’s foreword sets the
tone for this book. Rampage is sure to
be dismissed by some as yet another
brainless blockbuster, but this book
reveals how much thought and
attention has gone into both the story
and the effects. Director and producer
Brad Peyton underlines this in his
introduction, which explores how he

wanted to tackle bigger subjects, such
as animal cruelty and antipoaching.
The book starts proper with a
chapter that takes a look at its arcade
origins and scientific grounding before
leading into a chapter dedicated to the
two leads, Dwayne’s Davis, and
George. It’s this section that will prove
most fascinating to VFX fans, as we're

66 This book reveals how
much thought has gone into
the story and the effects 9

The final mutated form
of Lizzie the crocodile is
pictured against a
human for scale.

taken through the development of
George, an albino gorilla who mutates
into a monstrous super predator.

Considering this is both a making-of
and an art book, the artistic insights
are balanced out with explanations of
conventional characters and details of
the filming process. While these

Motion-capture performer Jason Liles helped to
bring George the albino gorilla to life.

sections are interesting, it’s the studies
of creature designs that will be the
main draw for many. These
breakdowns include words from Weta
Workshop effects supervisors, and do
a good job of revealing how George
builds on previous performance-

i captured actors found in The Lord of

the Rings and Planet of the Apes.

Elsewhere in the book, the evolution
of the city-destroying mutants that
clash with George are covered.
Although given comparatively less
page space, there’s still plenty of
design analysis here to enjoy. Topped
off with references to the game that
are sure to delight hardcore fans, both
the book and the film are painted out
to be a refreshingly heartfelt take on
your conventional action film.

RATING % % & k%



Inspiration Books

The Art of Paul Gerrard:
Monochromatic Beginnings

FANTASY FUSIONS The legendary concept designer revisits the
start of his career with this collection of black and white artworks

aul Gerrard specialises in
depicting dark and
surrealistic scenes. His
distinctive style of
nightmarish fusions has led to credits
on the likes of Battle: Los Angeles.
Werath of the Titans, Hellraiser:
Origins and The Shannara Chronicles.
Before all this though, Paul created
monstrous characters and dystopian

Paul created this
concept of an alien

in motion to help
inform his final design.

+ landscapes. And it’s these creations

that are brought together in the first of
a series of books put out by the artist.
As the title suggests, this period of
work saw Paul working in black and
white. “Monochrome was my chosen
palette at the time, allowing for a
heightened sense of realism,” he says.

Running at 80 pages, this glossy
hardback includes digital roughs that
emerged from meditation sessions
that saw Paul submerged in a
floatation tank, all the way through to
concepts for cinematic projects.

There’s lots of warped and uneasy
imagery to enjoy here, but unlike most
retrospective books there’s no
trajectory to the layout and not much
in the way of captions from the author.
While a bit disappointing, this

One of Paul’s unused concepts for the invading
biomechanical aliens from Battle: Los Angeles.

approach does fit with the artist’s
convention-bucking style. Fans will be

| pleased to hear though that this is the
first in a 10-part series of Gerrardian

collections, so there’s plenty of scope
to learn more.

RATING Xk Ky

Ann Blockley’s Watercolour Workshop

PAINTING PROCESS Discover new ways to paint with watercolours
in this book that focuses on innovative approaches to the medium

Author Ann Blockley Publisher Batsford Price £20 Web www.pavilionbooks.com Available Now

an art really be taught, or is

it a skill that a person

simply does or doesn’t

have? It’s a hotly debated
question, but in her latest book,
renowned watercolour artist and
teacher Ann Blockley shares personal
approaches to help bring out
everyone’s inner artist.

Ann reveals how to start looking at

subjects like an artist, as well as
exploring mindsets to help readers

WATERCOLOUR
WORKSHOP

Ann shows how she
adds small amounts of
concentrated pigment
for pollen details, which
contrast with the soft
colours used elsewhere.

expand their skills in an organic way.
She also examines an array of mediums
and tools, and how these can be
combined in unconventional ways to
achieve striking results. Yet the
walkthroughs and technique sections
never come across as didactic. They’re
more of a blueprint for readers to build

| on in their own way, with the help of
| their ever-growing creative sensibilities.

Diagonal, directional
sweeps of colour help
convey movement of
the flowers, together
with a crayon layer that
creates a loose
shimmer to the scene.

Designed to be read in any order,
Watercolour Workshop is as mutable
as its medium. Covering textures,
mark-making and scenery, before
moving on to monoprinting methods
and abstract compositions, it’s a useful
reference to have if you’ve struggled
to go with the flow of watercolours.

| RATING kK yy
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Workshops assets are available...
NO 1 FOR DIGITAL mmm If you see the video workshop badge then you can watch the artist

in action. Turn to page 8 to see how you can get hold of the video.

Tradltlonal Artist

Inspiration and advice from the best pro artists

This issue:

100 Traditional art FXPosé
Explore this month’s selection of
the finest traditional art, which
has been sent in by you!

104 Workshop: Draw an
iconic fantasy encounter
Nicolas Delort creates a dramatic
black and white clayboard
illustration of a The Lord of the
Rings scene.

110 Core Skills:
Watercolour

Join Kelly McKernan in
discovering how to work with,
not against, this wonderfully
surprising medium.

114 First Impressions:
Yoann Lossel

An ancient forest had a lasting
effect on this French artist...
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Traditional Artist FXPosé

XPosé

SHOWCASING THE FINEST TRADITIONAL ARTISTS
T

Gabriella Eriksson

LOCATION: Sweden MEDIA: Coloured pencil, oils, graphite, ink, Photoshop
WEB: www.gabriellaliv.gallery

“Most of my work gravitates towards the weird, dark
and emotional,” says Gabriella. “I find inspiration in
obscure textbooks, weird fiction and nature.”

B R 2 | tp

FLOAT

“In this illustration, | wanted to explore the
serenity that can be found in embracing
discomfort. | love draw to bodies with loose
and impossible anatomy.”

LEAP

“The idea behind this piece was to
capture someone pushing through their fear.
| used both sides of the Dura-Lar paper to
achieve the see-through effect on the body.”

LINGER

“| was inspired by the messy ways we
sometimes hold on to bad memories. Unlike
Leap and Float, there’s no clear divide
between the calm and the chaotic.”

liiaEsieX July 2018 Want to submit your work? Visit http://ifxm.ag/getinifx




Inspirational art

DELIRIOUS PORTRAIT

“A playful experiment that
turned into a trippy portrait
piece. | never meant this to
capture a specific person, but
rather to convey emotion.”

<l

E)

Want to submit your work? Visit http;//ifxm.ag/getinifx July 2018 liviagiieEX




Traditional Artist FXPosé

“ BUMBLECOPTER
£ - Jerel Dye “| drew this in ink then
ly LOCATION: US MEDIA: Pen and ink, marker, watercolour, Photoshop, Clip Studio Paint WEB: jereldye.com colour it digitally. It’s part of a
I Jerel's been creating sci-fi art and comics since 2009 and has SenEs oS Eatheliconter:
2 L . 3 style flying machines. In these
self-published a number of comics and stories for anthologies. b A o
He also teaches courses in drawing, cartooning and comics. playful mood.”

AERIAL STATION

“Part of a long-running
series inspired by
technological science fiction.
With each piece | took a
‘stream of consciousness’
approach in order to achieve
a tangible sense of liveliness
and discovery.”

NEW GROWTH I

“Narrative illustrations
can be a lovely form of
storytelling, even without
text. The images can tell a
more open-ended story,
leaving the viewer to
interpret them.”

PIGS MIGHT FLY COVER
“In this illustration |
wanted to give a sense of
the adventure and heroic
discovery. This adventure
is born out of innovation
and boldness.”

Want to submit your work? Visit http://ifxm.ag/getinifx




Inspirational art l

Want to submit your work? Visit http://ifxm.ag/getinifx
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[n depth Iconic encounter
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N ICONIC

FANTASY ENCOUNTER

NICOLAS DELORT shows you how to create a dynamic and dramatic black and
white claybord illustration by exploring all the possibilities the medium offers

onochromatic artwork

has always appealed

more than colour art,

whether it’s charcoal

sketches, etchings or
pen and ink. While I was still a
student, I saw an exhibit of
Rembrandt’s engravings at the
Louvre. I was blown away by the
detail and the dramatic lighting, and
it inspired me to try and mimic the
look with pen and ink.

My first attempts were messy but I
had fun doing them. I worked with
pen and ink for a while, trying to
replicate the look of wood or copper
engravings of other artist I
discovered, like Gustave Doré, but I
felt limited in terms of detail and it
was hard to produce clean, parallel
lines the way I wanted them to be.

So I did some research on ways [
could mimic the engraving “look”
without actually doing engraving and

MATERIALS

MEDIUM
B Ampersand Art
claybord

PENS

M Faber Castell Ecco
Pigment in 0.1, 0.3
0.5mm

B Uni Pin Fine Line in
0.05mm

M Faber Castell Pitt
artist pen ‘big brush’
SCRATCHING KNIFE
M Speedball scratching
knives 112 and 113

found out about early 20th century
illustrator Franklin Booth, who
worked on scratchboard. Since then
I've been working with Ampersand
Claybord and haven't looked back!
It’s a fantastic medium that gives you
lot of control over your lines.

It comes in two varieties - un-
inked and pre-inked - and the pre-
inked variety is called Scratchbord.

I use the un-inked kind, because it
enables me to work both in an
additive and substractive manner.
The image I've created for this
workshop will demonstrate how

I combine those two methods to
achieve the desired effect.

Creating art in black and white can
be deceptively simple, because you
have less means to create contrast
between different elements, so you
have to find workarounds. Although
it looks like you can correct your
mistakes by just scratching them out,

in reality things aren't that simple
and claybord is less forgiving than it
looks. It’s for that very reason that [
work slowly and methodically, to
leave as little as possible up to
chance. It's taken a lot of practice to
get a steady hand that enables me to
create smooth and even lines, but it's
been a rewarding process.

In this workshop, I'll try to explain
my process, showing how I use lines
to creature movement, values and
texture by rendering a classic scene
from The Lord of the Rings: the
encounter between Gandalf and the
Balrog on the bridge of Khazad-Dtim.

icolas is a freelance

Willustrator who specialises in
Woicck and white clayboard
L

hwebsite: www.nicolasdelort.com.|f oS




Traditional Artist Workshop

\

\

Thumbnailing stage
| always start out an illustration by doing very rough thumbnails with a pencil

on paper with printed frames. | like having frames already on paper because it

helps me focus on composition. | generally start with a pretty good idea of what

| want to do, but this phase helps me find the exact composition | want.

PEN TIP
MY FAVOURITE PENS
After trying out tons of
different pens and brands,
Faber Castell Ecco
Pigments are really
my favourite to use
on clayboard.

ARTIST INSIGHT

COMPOSITIONAL
RULES MAKE SENSE

They may sound rigid,
but compositional rules
such as the Rule of
thirds are Staples for a
reason! They are tried-
and-tested methods to
create balanced
compositions. Don’t

be afraid to break the
rules though!

3 Planning out the values
When I'm happy with my sketch, | do a quick
digital value study. | keep values simple and not too
detailed. It will serve as a reference guide when | do the
final, so | know where I’'m headed. | focus more on general
atmosphere and light source, rather than smaller details.

w IimasielX July 2018

Cleaning up the sketch

Once | have a thumbnail | like, | scan it, blow it up in
Photoshop, colour it light blue and then draw over it on
another layer. | use Kyle Webster’s Ultimate Pencil brush,
because | love its texture and flow. | don’t worry too much
about the details for now, but | make sure that | have
everything exactly where | want it to be.

Transferring the sketch to the board

| print out the sketch at the desired size (28x38cm)
and use transfer paper to trace it down on the board.

| don’t press down too hard on the carbon paper,
because it can be hard to erase from the board.



5 Outlining the dark areas
Using a 0.3mm tip Faber Castel Ecco pigment pen,
| outline areas that will be rendered in a substractive

manner. That means they will be first filled with black ink
and then I'll use a knife to scratch out lines. | generally
work from background to foreground, so | start with the
Balrog and smoke in the background.

s Y By

7 Working in the first values

At this step, | haven’t used my scratching knife yet.
| continue to fill in the areas that will be scratched out
later and at the same time, with a 0.5mm pigment pen,
| start working on the lighter areas by carefully creating
tones with parallel lines. | use the direction of the lines to
enhance the flow of the piece.

In depth Iconic encounter

- &
Filling in the dark
| use a Faber Castell Pitt “Big brush” pen to fill in
large areas and a 0.5mm pigment pen to fill in the smaller
areas. At this point it doesn’t really matter if | accidently
fill outside the lines because | can always scratch out later,
but | still try to be as clean as possible.

i

Completing the addition

ARTIST INSIGHT

THUMBNAILING

I’ve been advised
against it several times,
but | like doing my
thumbnails in pre-
drawn frames. It helps
me plan out the
composition and not
go all over the place.

| continue working in values on the background with the 0.5mm pigment
pen, always paying attention to the general flow of my lines and movement that
they create when you look at the illustration from afar. The Balrog is made of fire,

and so | want it to look like its form is ever-changing. #»
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Traditional Artist Workshop

4

0 Depicting insubstantial wings

Building values with scratched lines | continue scratching out lines to create values in

At this point, the areas in the background that have to be worked in an the background. | want the wings to look like they’re
additive manner are done. | take out my scratching knife and start working in the made of smoke or shadow, so | don’t give them definite
darker areas, again by creating tones with very thin parallel lines. | can vary the line shapes. The hardest thing at this point is to keep a clear
weight to create different values by applying less or more pressure on the knife. idea of what | want the final values to be.

SURFACE
TIP

CLAYBOARD OR
SCRATCHBOARD?
| prefer clayboard because
| like taking both additive .-
and substractive
approaches.

ARTIST INSIGHT

CLEANING UP A SCAN

| avoid using scanning
software to do any
adjustments. Instead |
scan without changing
any of the settings so |
obtain a raw scan that’s
easier to retouch using
Photoshop’s Levels and W
Curves tools.

- e

Lightening with counter-scratching
| use my scratching knife to “counter-scratch” some of the pen lines at a 45 degree angle to create dashes. It
lightens the values and create subtle gradients. Now the transition between the pen lines and the white looks smoother.

w IimasielX July 2018




) Darkening and creating texture

In depth Iconic encounter

At this point, all the areas in the background are scratched out but to create some darker values, | take my pens and counter-hatch the

scratched lines like | did with the knife. Doing this with a pen on the scratched lines darkens the values and also creates an interesting texture.

Completing the foreground
Now that the background is finished, | can move
on to the foreground. The lines on the rock and bridge
are straighter than in the background, so we have a
contrast of textures. | wanted the halo from Gandalf’s
staff to be stylised and geometrical to contrast with the
rest of the piece, where the shapes are more organic.

u Digital touch-ups
Now that the piece is complete, | scan it in and do some digital touching up.
The scan makes the ink look washed out, so | re-adjust levels so that the black is
black and the white is white. | also add some subtle levels of grey to add some

depth and to give the lighter areas a bit of a glow. #
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Traditional Artist Workshops

Core skills: Part 1

WARMING UP TO
WATERCOLOUR

Come on in, the water’s fine! Join artist and teacher KELLY MCKERNAN in
discovering how to work with, not against, this wonderfully surprising medium

hen someone finds |

out that I work
in watercolour,
their immediate
response is often
“But watercolour is so hard!” An
unsurprising reaction, perhaps...

I discovered watercolour as a
teenager, and instead of being
intimidated by its unpredictable
nature, I saw endless possibilities.

I gradually realised that watercolour
offers a unique, collaborative
relationship with the artist - one that
isn't so straightforward and requires
experimentation, openness and most
importantly, patience.

By its very nature, watercolour
appears to be a difficult beast to

| tame. After all, its primary vehicle is
| water! It’s key to bear in mind that

there’ll always be an element of
surprise when working with
watercolour. Over time and with lots
of experimentation and
implementation of tried-and-true
techniques, I've learned first to
control what I can, and as for the rest,
work intuitively and allow
watercolour to be watercolour. At
times it will take the wheel whether
you like it or not, but you'll live for
those moments when it pleasantly
surprises you!

As well as having an open mind
and endless patience, working with
watercolour requires a particular
setup, proper materials, a little
technique and a lot of
experimentation. In this series,

I'm going to share with you how

I work with this incredibly versatile
and exciting medium and make the
best of watercolour’s delightfully
protean nature.

]
who creates original paintings

tudents via her Patreon. You can see more

of her art at www.kellymckernan.com.

Cold press watercolour paper.

]

\
Hot press watercolour paper.

What different watercolour papers are available?
Watercolour paper comes in three textures: hot, cold and rough. Both cold and rough watercolour paper have a bumpy texture, and will

give you more vibrant colours. However, | enjoy working with hot press because the smooth texture enables me to achieve sharper details.
Watercolour paper also comes in various weights. | recommend starting with 140Ib. The heavier it is, the less likely it is to buckle under a lot of
water. Aim to use top-brand papers such as Arches or Strathmore, because the quality of your paper is very important.

w IimasieX July 2018



Core Skills Watercolour

#7 Size 1 liner sable brush.

e 2 Choosing your brushes
W

Watercolour brushes can

vary widely and it can be tough

Size O Kolinsky sable brush. making a decision on which ones to
buy. There are b9th synthetic and
natural hair brushes available for
watercolour use, and each have
their own strengths. | prefer to
work with Kolinsky red sable
brushes, because the natural fibres
hold liquid better than synthetics
Size 1 Kolinsky sable brush. can, although they are more
expensive. Brushes come in many
shapes as well, though | most
commonly use Rounds ranging
from size Oup to 6. B>

=

Size 2 Kolinsky sable brush.

Size 3 Kolinsky sable brush.

Size 6 Kolinsky sable brush.

Size 1squirrel hair mop brush.

July 2018 lifidgiieRX




Traditional Artist Workshops

A nice perk to working
with watercolour is that it
can always be re-wetted
when dried, so an old
palette can be brought
back to life in a snap.

/

3 Select a watercolour palette that suits your way of working

Responsible watercolour artists typically use a large palette divided into wells for their colours. My particular method of working with
limited colour palettes has landed me on a small, cheap eight-well palette with two mixing areas. | keep several around, including larger circular
palettes in rotation, so that | can dedicate one per painting. This is useful when I’'m working on more than one piece at a time.

G T T R

A Pick your paints
Watercolour paints most
commonly come in tubes or pans.
| prefer to use watercolour tubes
because | can achieve better intensity
right off the bat. | work with several
brands, but my favourites are
Grumbacher and Winsor & Newton
for basic colours, and Daniel Smith for
speciality colours and those that
granulate nicely. My techniques for
creating texture take advantage of
the pigment separation that comes
with these speciality colours. Student-
quality watercolours won’t get you
very far, so I'd recommmend spending
a little extra on the good stuff, since
you'll have it for some time anyway.
Some of my current rotation of
watercolours are over five years old!

Here are some of my most frequently
used watercolours, along with speciality
Finetec gold and silver pans.




Core Skills Watercolour

 —

My trusty ceramic

water mug. \__‘?

3M blue painter’s tape,
used for masking as well
as taping loose paper.

{

Coarse ice cream
salt, best for large
areas of texture.

Fine kosher salt,
for small areas
of texture.

Askifs
DE FRISQUET

L =
LIS 'SKET LIQUIDY
N POSUSEMAY Chirt h
e
ﬁnslﬂ i PUEL
Y0 o s

RN T TR ey
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- i ; Kneaded
IO - eraser.

Grafix Original
Incredible Nib that
| use for applying
masking fluid.

#10 Grmbacher
Miskit Frisket
masking fluid.

/ I y o o
#9 Standard mechanical / ; \. * 4 Additional tools

pencil that | prefer to use - - y My favourite part of working with
" \\. "#7 Molotow masking

for sketching. fluid pen. watercolour involves the tools that push the

medium even further. | most commonly use kosher
. salt and ice cream salt for texture effects (the latter
I e i _ creates larger texture). I'll also occasionally mask to
Mono Eraser pen. . preserve an area of paper with the aid of masking

: fluid or tape. These technique will be covered in
future instalments of this series. Stay tuned! g
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An ancient forest had
a lasting effect on
this French artist...

Where did you grow
up and how has this
influenced your art?

I grew up in Nantes, in
the west of France. But
my family comes from all over
France, and especially from
Strasbourg, to the east of France.
These are two regions with different
identities and established cultures.
This gave me the taste of history,
architecture, the desire to settle my
work in the roots of art.

What, outside of art, has most
influenced your artwork?

Nature and the study of myths and
legends. After my studies, I went to
live in Brocéliande, a forest in
Brittany. This place is known to be
associated with the Arthurian
legend, in addition to the Breton
folklore. By extension, Brocéliande is
associated to the Pre-Raphaelite
painters and illustrators of the
Golden Age, which are among my
major influences in addition to
Symbolist painters.

Does one person stand out as being
helpful during your early years?

GRENDEL'S
MOTHER’S MERE

Yoann created this illustration
for a limited edition of Beowulf,
published by Easton Press.

He used graphite, hydrangeas
petals, gold (24k), silver and
copper leaf to depict the scene.

Traditional Artist Interview

¢ One of my uncles is a long-time fan

i of role-playing games. He had a large
figurine collection that I look at as a
child. It was my first encounter with
fantasy in a broad sense.

What was your first paid

: commission, and does it stand as a

representation of your talent?
Several illustrations of a tale for a

66 I think fantasy art is
regaining the recognition
and exposure it deserves 99

WEALHTHEOW

This is another piece of art for
Easton Press’s edition of
Beowulf. Yoann produced

10 pieces of art for the book,
which had a limited print run
of just 1,200.

| fantastic French magazine The

' Magic Cauldron. I don't think it’s
i representative of my work, but I

i liked doing it.

What's the last piece you finished,

i and how do the two differ?

! A painting for a French fantasy film.
| Today, I take all the time I need to

| complete a project - the goal being

i to create a subtle and elegant

artwork. I'm happy when my work
has several levels of interpretation.

What are your painting rituals?

I read a lot about my subject to
capture the symbolism of my theme.
I visualise my image and evolve it in
my mind until it favours my subject.
I create the dynamics of the
composition with the first sketches,
finish my sketch, paint with graphite
wash, design my ornaments on a
layer, gild my interlacings and other
gold parts and then varnish.
Throughout the process I listen to a
lot of music and conferences.

How is your art evolving?

My art evolves at the same time as
me. We work together. My last
experiment was to add relief to my
work and expand my gilding skills.

What is the most important thing
that you've taught someone?

I don't know, you should ask around
me. Perhaps to always be faithful to
your aspirations.

What advice would you give to your
younger self to aid you on the way?
Hold your course, the rest is exciting.

How has the industry of fantasy art
changed for good since you've been
working in it?

I think we're taking it more seriously.
Today, I work with luxury, high-end
clients, and I'm not sure that would
have been possible at the beginning
of my career. I come from a country
that, until recently, saw painters like
Gustave Moreau or Alphonse Mucha
at the centre of a cultural influence. I
think fantasy art is regaining the
recognition and exposure it
deserves. There’s no reason for it to
remain a “minor” art. I'm absolutely
convinced that the coming decades
will be interesting for fantastic art
and fantastic artists.

more of his art at www.yoannlossel.com.



" PUT A PAUSE
" IN YOUR DAY

Y With so many demands from work, home and family,
there never seem to be enough hours in the day for you.
Why not press pause once in a while, curl up with your
favourite magazine and put alittle oasis of ‘you' in your day.

PRESS PAUSE

ENJOY A MAGAZINE MOMENT

To find out more about Press Pause, visit:

pauseyourday.co.uk



Always remember to...

SAVE
SAVE
SAVE

Save time by learning from the pros at
DigitalArtTutorials.com
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